4-296-436-11 (2)

SONY.

Multl Format
Compact Switcher

Operating Instructions (Volume II Advanced Settings)

Before operating the unit, please read this manual thoroughly and retain it for future reference.

MCS-8M

Software Version 1.00

HuoITil

© 2011 Sony Corporation

Download from Www.Somanuals.com. All Manuals Search And Download.



II-2

Table of Contents

(this manual)

Chapter 1 Overview

Introduction 1I-5
System Configuration Examples ........cc.ccceeeveneninencnencnnnnn. 1I-5
Chapter 2 Video Switching
Overview 1I-7
Setting the Transition Type 11-7
General Transition Settings ([Misc] menu)............... 11-8
Bus Delegation 11-9
Using the Bus Delegation Buttons .........cc.cceceevevienienenieneneen. 11-9
Mixing Video Created with M/E (Mix/Effect) with
Other VIdeo......cocoiiiiiiiiiiiiiiieiececececee e
Setting Wipes
Basic Operations fOor Wipe ........cc.coceeruerienirnienienenieneene e
Selecting the Pattern and Direction for Wipes ....
Making Detailed Adjustments to Wipe Patterns ..........cccccce..

Adding the Edge to the Wipe Pattern ..........c.ccocceeeeeneinenneenens
Setting DME Wipes

Basic Operations for DME Wipe

Selecting the Pattern and Direction for DME Wipes ............... 1I-13
Making Detailed Adjustments to DME Wipe Patterns ............ 1I-13
Adding an Edge to a DME Wipe Pattern .......c..ccccoceveveuennnn. 1I-14
Adjusting the Background Color of a DME Wipe ................... 1I-14
Details on [Effect] Menu II-15
[EffECt] MENU ....cvviiireeiieeeee ettt e II-15
[Wipe Modify] Menu .... .GI-16
[DME Wipe Modify] Menu........ccccocuvirerenenenenieicieieneeenen II-18
Setting Keys 11-19
Basic Operations for Keys.........cocueverieniineniienenieneenceieneee II-19
Setting Key Transitions ........cc.cceceeveeveenueneenieneenne ...11-20
Selecting the Pattern and Direction for Key Wipes.................. 11-20
Making Detailed Adjustments to Key Wipe Patterns............... 11-20
Setting Key DME WiPes ......ccccovieiiiiiniiiiinieniieiesieeee e 11-20
Making Detailed Adjustments to Key DME Wipe Patterns.....I1-21
Selecting Key TYPes.....cooeeveerienenieneeienicicnieeene LGI-21
Making Detailed Adjustments to the Luminance Key ............. 11-21
Making Detailed Adjustments to the Linear Key............cc....... 11-21
Making Detailed Adjustments to the Chroma Key .................. 1I-21
Setting the Key Fill and Key Source...........ccccceevvenienennennenns II-21
Setting a Mask for @ Key ......ccceveiiiniiiiniiiiiiiinieieeeeeee 11-22
Adding an Edge to a Key......ccoceeuiniiniiniiniiienieeceeee e 11-22
Adjusting the Size and Position of the Key........c.cccccevceenennne 11-22
Details on [Key] Menu 11-23
[KEYT MENU ..ottt ettt 11-23
[RESIZET] MENU ..coovvviiiiiiiieieeeiee ettt e 11-26
[Auto Chromakey] Menu ..........cccccevveereenieneenienienieiceieseeene 11-27

Table of Contents

[Manual Chromakey] Menu .........ccceeceererieneeneneeneeieneeeenne 11-28
[Key Wipe Modify] Menu........ccccevueneeneenieneenienieneeicneeienne 11-29
[Key DME Wipe Modify] Menu...

Chapter 3 Audio Mixing

Overview
Details on [Audio Channel] Menu...........ccccevveevencnces 11-31

Chapter 4 Inputimage Freezing and Frame
Memory

11-34
I1-34

Overview

Freezing Input Images

Selecting Frame Memory for Use as Frame Memory

Video (FM) I1-35
Saving Images to Frame Memory ............cceueueeueunene I1-35
Importing and Exporting Images 11-36

Importing IMages......c..covevveieiiniiienireccereeecee e II-36
Export Frame Memory .........ccccccooiiiiiiiiiiiiiiciciiccice I1-36

Chapter 5 Importing and Exporting Files

Importing and Exporting Configuration Data ........ 11-37
Exporting Configuration Data ...........cccceceevveineineinncinenns 11-37
Importing Configuration Data ...........cccceceveveineeneinecinenns I1-38

Importing and Exporting Snapshots..........c.ccceceueuce. 11-38
EXporting Snapshots ........ccceuecirieinieciniinieeineeeeeeeee e II-38
Importing Snapshots..........ccccvevivirininiiiienereeccceeee I1-39

Formatting a USB Flash Drive 11-39

Chapter 6 3D System

Overview 11-40

Making the Necessary Settings I1-41
Setting the Signal Format and Video Size.........c.cccoceevenienenne 11-41

Turning 3D Mode On ........coveiivieniiriieniene et
Confirming 3D Video Output....

Chapter 7 Controlling External Devices

Enabling/Disabling Operation from External

Devices 11-43
Connecting with External Devices............cccceeceueucnc. 11-43
Setting GPIINPULS ......c.ooviiiiiiiiiiiiciceecccceeeeee 11-43
Setting GPI Outputs/Tallies..........coevererenenenieieicececeneens 11-43
Details on [GPI/Tally] Menu 11-44

Download from Www.Somanuals.com. All Manuals Search And Download.



Chapter 8 Setup ([Setup] Menu)

Table of Contents
(Volume I Basic Operation)

Overview 11-47
System Setup (System) 11-47
Details on [System] Menu ........ccceoeevuerienirnenieneeieneeneeneenae 11-48
Audio Setup (Audio) 11-49
Details on [Audio] MENU.........cccveeeeevieeeeiinieeeeieeeeeeeieee e 11-49
Video Input Setup (Video (Input)).......ccceeueecrueeucnes I1-51
Details on [Video (Input)] Menu.........cccceeververininencncnenenne. II-51
Assigning Video Input Signals to the Cross Point
Buttons (Video (XPT)) I1-52
Using the Shift Button Function..........c..coceeoeniiiinieninncinnns 11I-52
Details on [Video (XPT)] MenU........cccceeevviervieeeriecieeeieeeneenns 11-52
Video Output Setup (Video (Output))..........ccceueueuees I1-53
Details on [Video (Output)] Menu ......c.cccceeeeveriviinerenenenene. 11I-53
Setup of Other Video Related Items
(Video (Misc)) 11-54
Details on [Video (MiSC)] MENU .......cccveevveeniieiieeeieeeveeeeens 11-54
Displaying Various Information (Information)....... 11-54
Installing Application Software and Firmware
(Install) 11-54
Appendix
Message List I1-55
EITOTS ottt II-55
WAMNINZS ...ttt II-56
INfOrmMation .........coevueviiriiniiniei e I1-57
Index 1I-58

Chapitre 1 Overview

Introduction

Names and Functions of Parts

Chapitre 2 Preparations
Connecting Devices

Configuring System Settings
Configuring Video Signal Settings
Configuring Audio Signal Settings
Configuring Multi Viewer Settings

Chapitre 3 Basic Operations
Switching Video

Composing Images with Keys
Mixing Audio

Snapshots

Saving and Selecting Settings

Appendix
Effect Pattern List
Troubleshooting
Maintenance
Specifications

Index

Table of Contents

Download from Www.Somanuals.com. All Manuals Search And Download.

I1-3



About This Manual

This manual describes how to make adjustments and
settings to enable you to use the advanced features of this
unit.

For the basic operating procedures of the unit, see to “Operating
Instructions (Volume I Basic Operation).”

How to View This Manual

About setting values

The setting values shown in bold are the factory default
settings.

Examples:

Knob |Parameter | Meaning Setting range
V3 Format Signal format | 108059, 108050,
720p59, 720p50,
480i59, 576i50,
Test1, Test2, Test3

V4 Aspect Aspect ratio 16:9, 4:3

About references

References to the Operating Instructions (Volume I Basic
Operation) are indicated by the = mark as follows.

Example 1:

Channel faders (< Basic Operation: “Names and
Functions of Parts”)

Example 2:

For details, see “Effect Pattern List” (® Basic

Operation).

To find information on a specific topic

See “Index” (page I1-58) at the end of this manual.

The index indicates whether the information can be found
in “Volume I Basic Operation” or “Volume II Advanced
Settings” and the corresponding page numbers.

11-4 i
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Overview

Chapter

Introduction

The unit allows you to adjust and set video effects, transitions, and audio in detail to
perform more sophisticated switching. You can also perform 3D video switching,
and use the frame memory function to write one screen of the input video to memory
so that you can use it as input material.

System Configuration Examples

Example 1: When SD system

Presenter
microphone

Projector

Host microphone

A
MIC/LINE J
( MIC/LINE
DVI-I
CD/DVD
( player
USB flash drive
(CG material)
Multi Viewer display
e SDI v Y Y i LINE
S SO < J
Camera with VIDEO output -0
DVI-D
0o o o_o.. DVIeHDMI L ———=
@E o conversion cable —
o °700Dﬂ
oe (OO O
- J —
Recording equipment ) n n
with SDI output DI Headphones
oo 0p0.u
PGM monitoring display Sl @S o @ o m
|88 Ol—Tc o
= oeo (00000 ©F
™
PGM Recording equipment
PA. etc. with SDI input

L

Introduction
Download from Www.Somanuals.com. All Manuals Search And Download.
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Example 2: When 3D system

Presenter Host microphone

microphone
MIC/LINE MIC/LINE

MaInIBnD | Jaidey)

Right camera Left camera

CD/DVD
( player

HD SDI
(L) Multi Viewer display
HD SDI (R) LINE
Y Y
Right camera Left camera N | @ “
8 ca @ DVI-D
oo o
R DVI<HDMI —
ocooo |Conversion cable
oDoDD
ooo
—_—
HD SDI (R) J won
oo ©.0..

J Headphones
HD SDI {

PGM toring displ HD SDI (L+R) BE 0 oio 1
GM monitoring display (PGM L, PGM R) ﬁE ) oo
oH

— o (0000000
=

Recording equipment
PGM . H
PA, etc. with HD SDI input

Y

N

For details on configurations for 3D systems, see “Chapter 6: 3D System” (page 11-40).
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Video Switching

Overview

This unit allows you to apply various effects when
switching video, and compose images using keys.
Adjustments and configurations during video switching
are performed from the following menus.

Menu Description Reference
page
Misc Set general transition settings 11-8
(e.g., transition rates, color
backgrounds).
Effect Set the transition type. -7
Set the wipe. 1I-10
Set the DME wipe. II-13
Key Set the key. 11-19

In addition, this unit includes three video composition
blocks, M/E (Mix/Effect), Aux1, and Aux2. By using
Aux1 or Aux2, you can mix video (PGM) created with M/
E (Mix/Effect) with another video.

For details, see “Bus Delegation” (page II-9).

Chapter

Setting the Transition
Type

You can specify the transition type that is used when you

perform effect transitions.

You can select any of the following transition types.

Wipe: Use a wipe to switch from the current output image
to a new image.

NAM (Non-Additive Mix): Compare the current image
and new image signals, and gives priority to the signal
with the highest luminance level in the output.

For the first half of the transition, the current image is
maintained at 100% and NAM is gradually performed
for the new image. At the halfway point, NAM is
performed for both images which are maintained at
100%. In the second half, the new image is maintained
at 100% and NAM is performed while the current
image is gradually reduced.

DME (Digital Multi Effects): Use DME effects to
switch the image currently being output in a manner
that appears as if it is being wiped (DME wipe).

Settings menu: [Effect] menu > [Effect Transition]
(page II-15)

Overview / Setting the Transition Type

Download from Www.Somanuals.com. All Manuals Search And Download.
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General Transition Settings ([Misc] menu)

You can set the transition rate and the color background (ColBg) with the items in the [Misc] menu.
Press the MISC button in the menu control block to display the [Misc] menu.

Menu item | Description Knob | Parameter | Meaning Setting range
Transition | You can set the time (transition rate) it takes to switch V2 Effect Transition rate for |1 to 999
Rate (1/2) |videos when a transition is executed with the AUTO effect transition | frames (30)
TRANS button, KEY TRANS button, or FTB button for V3 Key Transition rate for | 1 to 999
each transition. key transition frames (30)
V4 FTB Transition rate for | 1 to 999
¢ The transition rate for effect transition can also be set FTB frames (30)
Transition under [Effect Transition] in the [Effect] menu. V3 | Auxi Transition rate for | 1 to 999
Rate (2/2) (See page II-15) Aux1 frames (30)
* Key transition rates can be set under [Key Transition] in [y/4 AUX2 Transition rate for |1 to 999
the [Key] menu. (See page 11-23) AUx2 frames (30)
Color A color signal can be generated within the unit and used | V2 Lum Luminance 0.00 to 100.00
BKGD as a single-color background. Color signals can be V3 Sat Saturation 0.00 to 100.00
assigned to the cross point buttons (PGM button and Va Hue Hue 359.99 to 0.00
PST/KEY button) and then used.
Port Enable or disable the GPI and RS-232C ports which are |V3 GPI Enables/disables | Enbl (enable),
Enable used for operation from external devices. GPI port Disbl (disable)
For details on controls for external devices, see “Chapter 7: Controlling V4 RS232C Enables/disables | Enbl (enable),

External Devices” (page 11-43).

RS-232C port (for
future expansion)

Disbl (disable)

General Transition Settings ([Misc] n?:%w
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Bus Delegation

This unit includes three video composition blocks, M/E (Mix/Effect), Aux1, and Aux2. Each block includes four or two

buses and can execute transitions.

However, Aux1 is dedicated to Aux1 PGM bus and Aux1 PST bus mixing, Aux2 is dedicated to Aux2 PGM bus and Aux2
PST bus mixing, and wipes, keys, and other effects cannot be added to either.

Video input Video output
PGM Bus
PST Bus Preview
Key Fill Bus (Mix/Effect)
Program
Key Source Bus

Aux1 PGM Bus

Aux1 PST Bus

Aux1 Preview

Aux1 Program

Aux2 PGM Bus

Aux2 PST Bus

Aux2 Preview

Aux2 Program

Using the Bus Delegation Buttons

Turn on (i.e., light) one of the following buttons by
pressing it to select the control objects for the cross-point
control block and transition control block.

Bus Obiject for control
gﬁlt?g:tion Cross-point control block Transition
PGMrow |PST/KEY row |control block
BKGD PGM bus PST bus MIX, EFF
KEY PGM bus Key Fill bus, Key |MIX, EFF
Source bus
AUX 1 Aux1 PGM | Aux1 PST bus MIX only
bus
AUX 2 Aux2 PGM |Aux2 PST bus | MIX only
bus

To select a key source
Press a PST/KEY cross-point button while holding down
the KEY button.

Download from Www.Somanuals.com. All Manuals Search And Download.

Mixing Video Created with M/E (Mix/
Effect) with Other Video

By using Aux1 or Aux2, you can mix video (PGM) created
with M/E (Mix/Effect) with another video.

This section describes the procedure for using Aux1 as an
example.

Preliminary settings

1 Select the Aux1 program as the program video output.

Settings menu: [Setup] menu > [Video (Output)]
menu (page 11-53)

2 Set Aux! as the reference signal for the on-air tally.

Settings menu: [Setup] menu > [GPI/Tally] menu >
[On Air Source] (page 11-46)

Bus Delegation
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Mixing operation
1 Press the AUX 1 bus delegation button.
2 Select a PGM in the PGM cross-point buttons.

3 Select the signal you want to mix in the PST/KEY
cross-point buttons.

4 Execute the transition using the fader lever, CUT
button, or AUTO TRANS button.

Tip

Aux1 and Aux2 settings are not stored in snapshots.

Setting Wipes

Setting Wipes

A wipe is a transition effect that switches to the next video

by applying an effect that removes the program output

video in a manner that appears as it is being wiped off with

the video to be output next.

With this unit, you can make the following settings.

* Selecting the Pattern and Direction for Wipes (page
1I-11)

* Making Detailed Adjustments to Wipe Patterns (page
1I-11)

* Adding the Edge to the Wipe Pattern (page 11-12)

This section describes wipe effects and basic operations
for wipes.
Wipe settings are made in the [Effect] menu.

For details on the menu item, see “Details on [Effect] Menu” (page I1I-15).

Tip

The [Effect] menu does not appear in 3D mode.

Basic Operations for Wipe

| Select the video for program output. |

|

| Select the next video for output. |

|

| Press the EFF transition type selection button. |

|

| Set the transition type to [Wipe]. |

|

| Select the pattern and direction for the wipe. |

|

| Make detailed adjustments to the wipe pattern if necessary. |

|

| Execute the transition. |

Download from Www.Somanuals.com. All Manuals Search And Download.



Selecting the Pattern and Direction
for Wipes

A wipe can be set to proceed in either the normal wipe
direction (normal) or reverse wipe direction (reverse). You
can also specify normal and reverse to be switched each
time a transition finishes (normal/reverse).

Setting the wipe position

The wipe position can be set in the [Wipe Modify] menu

or with the X-Y pointer in the menu control block.

>

Positioner Off

Positioner On

N

/7

L
'd N / N

Reverse

Normal

Selecting the wipe pattern

You can select the wipe pattern using one of the following

three methods.

* Select from the patterns assigned to the numeric buttons
(direct selection).

For details, see “Selecting Effects with the Numeric Keypad (Direct
Selection)” (® Basic Operation)

* Enter the pattern number with the numeric buttons.

For details, see “Specifying effects by pattern number” (¥ Basic
Operation).

* Specify the pattern number in the [Effect] menu.

Specifying the pattern number in the
[Effect] menu

Settings menu: [Wipe Adjust] (page II-15)

For details on the wipe pattern numbers, see “Effect Pattern List” (9 Basic
Operation,).

Making Detailed Adjustments to
Wipe Patterns

You can set the position of a wipe pattern and apply
various variations and modifiers in the [Wipe Modify]
menu.

To display the [Wipe Modify] menu
Display the [Effect] menu, turn the V1 knob to select
[Wipe Adjust], and press this knob.

Download from Www.Somanuals.com. All Manuals Search And Download.

Settings menu: [Wipe Modify] menu > [Positioner]
(page 11-16), [Positioner Adjust] (page 1I-16)

To set the position with the X-Y pointer

Press the POS button in the menu control block so that it
lights up and then adjust the position by controlling the
X-Y pointer.

Setting the rotation method of a wipe
pattern

You can select from the following three rotation methods
for wipe patterns.

Angle
Performs the wipe with the pattern inclined at a fixed
angle.

Angle Off

Angle On

Speed
Rotates the pattern at a fixed speed during the transition.

\

Magnitude

Rotates the pattern at only the set angle for one transition.

N 2

Settings menu: [Wipe Modify] menu > [Rotation]
(page II-17), [Rotation Adjust] (page 1I-17)

Setting Wipes
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Setting the aspect ratio of a wipe pattern

You can freely change the aspect ratio of a wipe pattern.

—

Buiyoms ospIA g Jeldeyd

II-12

Aspect Adjustment Off Aspect Adjustment On

Settings menu: [Wipe Modify] menu > [Aspect]
(page 1I-17)

Replicating a wipe pattern

The same pattern can be placed up to 63 times either
horizontally or vertically, or in both directions.

&

Multi Function Off

L A 4
L B
oo

Multi Function On

—

Furthermore, you can select from the following four
methods for placing the patterns.

1 2 3 4

A 4

A A A 4
A A A A A V N V Xy

: All of the patterns are oriented the same way

: Even numbered rows are moved in the horizontal
direction

3: Even numbered columns and even numbered rows are

reversed

4: Even numbered columns and even numbered rows are

reversed and even numbered rows are moved in the

horizontal direction

DN =

Settings menu: [Wipe Modify] menu > [Multi]
(page 11-17), [Multi Adjust] (page 11-17)

Setting Wipes

Adding the Edge to the Wipe Pattern

You can add a border around the pattern (border), defocus
the edge around the pattern (soft), and defocus an added
edge of border (soft border).

The edge color can also be adjusted.

Soft Edge

*B

Border

Soft Border

Border: You can adjust the width of the border.

Soft Edge: You can adjust the defocus condition for the
edge.

Soft Border: You can adjust the width of the border and
the defocus condition for the edge of the border.

Settings menu: [Wipe Edge] (page II-15), [Wipe Edge
Color] (page II-15)
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Setting DME Wipes

DME wipes are effects that use DME (digital multi effects)

to switch the image currently being output in a manner that

appears as if it is being wiped.

With this unit, you can make the following settings.

* Selecting the Pattern and Direction for DME Wipes
(page 11-13)

* Making Detailed Adjustments to DME Wipe Patterns
(page I1-13)

* Adding an Edge to a DME Wipe Pattern (page 11-14)

* Adjusting the Background Color of a DME Wipe (page
1I-14)

This section describes DME wipe effects and basic
operations for DME wipes.
DME wipe settings are made in the [Effect] menu.

For details on the menu item, see “Details on [Effect] Menu” (page II-15).

Basic Operations for DME Wipe

‘ Select the video for program output. ‘

|

‘ Select the next video for output. ‘

|

‘ Press the EFF transition type selection button. ‘

|

‘ Set the transition type to [DME]. ‘

|

‘ Select the pattern and direction for the DME wipe. ‘

|

Make detailed adjustments to the DME wipe pattern if
necessary.
!

‘ Execute the transition. ‘

Selecting the Pattern and Direction
for DME Wipes

For details on the pattern and direction for DME wipes, see “Selecting the
Pattern and Direction for Wipes” (page II-11).

Settings menu: [DME Wipe Adjust] (page II-15)

Download from Www.Somanuals.com. All Manuals Search And Download.

Making Detailed Adjustments to
DME Wipe Patterns

You can adjust the position of a DME wipe pattern, adjust
the size of the sub-screen for during PinP, perform
cropping to cut the edge of the image, and make other
settings in the [DME Wipe Modify] menu.

To display the [DME Wipe Modify] menu
Display the [Effect] menu, turn the V1 knob to select
[DME Wipe Adjust], and press this knob.

Setting the DME wipe position

The wipe position can be set in the [DME Wipe Modify]
menu or with the X-Y pointer in the menu control block.

Settings menu: [DME Wipe Modify] menu >
[Positioner] (page II-18), [Positioner Adjust]
(page 1I-18)

To set the position with the X-Y pointer

Press the POS button in the menu control block so that it
lights up, and then adjust the position by controlling the
X-Y pointer.

Adjusting the size of the sub-screen used
for Frame In/Out and PinP

You can adjust the size of the sub-screen that appears when
you use the Frame In/Out and PinP DME wipe patterns.

Settings menu: [DME Wipe Modify] menu > [Size]
(page II-18)

Cutting (cropping) the edge of an image

You can crop portions of the image that are unnecessary.

The crop function is not available in the following cases.

* When the mosaic or defocus effect pattern is selected

* When the KEY next transition selection button is
selected

Settings menu: [DME Wipe Modify] menu > [Crop H]
(page II-18), [Crop V] (page 1I-18)

Setting DME Wipes
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The cropping process when the transition is executed is as
follows.

== Transition
== Crop

A
(%)
100

== Transition
== Crop

A
(%)
100

95

I
]
I
I
I
I
I
I

_______ >t
0 D
95 100 (%)

Last 5%

== Transition
== Crop

A
(%)
100

Linear

t: Transition execution time
y: Amount of change of transition and crop

Cut: Cropping is maintained during transition
execution and then removed at the point in time
that the transition ends.

Last 5%: Cropping is maintained as is until the
transition progresses to 95% and then removed
during the remaining 5%.

Linear: Cropping is linearly removed from the start of
the transition in accordance with the progression
of the transition.

Setting DME Wipes

Adding an Edge to a DME Wipe
Pattern

With a DME wipe, you can add a border around the pattern
(border) and defocus the edge of an added border (soft
border).

The edge color and background color can also be adjusted.

For details on how to add an edge, see “Adding the Edge to the Wipe
Pattern” (page II-12).

Settings menu: [DME Wipe Edge], [DME Wipe Edge
Color] (page 11I-16)

Adjusting the Background Color of a
DME Wipe

You can adjust the background color of a DME wipe.

Settings menu: [DME Wipe Bkgd Color] (page 1I-16)

* The background color of the DME wipe can only be used
for Flip Tumble DME wipe patterns.

* The background color of the DME wipe is shared with
the edge color of the wipe pattern.

Download from Www.Somanuals.com. All Manuals Search And Download.



Details on [Effect] Menu

[Effect] Menu

Press the EFF button in the menu control block to display the [Effect] menu.

Menu item | Description Knob | Parameter | Meaning Setting range Reference —
page —
Effect Set the transition rate and transition type |V3 Rate Transition rate 1 to 999 frames -7 o
Transition |that is used when you perform effect when executed | (30) _ncri
transitions. with the AUTO ]
TRANS button n
V4 Type Transition type Wipe, NAM, DME §
Wipe Set the wipe direction and wipe pattern. | V1 Modify Press the knob |- 1I-10 3,
Adjust You can also press the V1 knob to display to display the %
the [Wipe Modify] menu (page I1I-16). [Wipe Modify] =
menu B
V3 Direct Wipe direction Norm (normal), 1I-13
N/R (normal/
reverse), Rev
(reverse)
V4 PtnNum Wipe pattern 1to0 24
number
Wipe Edge | Add a border around the pattern (border), | V2 Type Wipe edge type |Off, Border, Soft |II-12
defocus the edge around the pattern (soft edge),
(soft), and defocus an added border (soft S-Brdr (soft
border). border)
V3 Width Adjusts border |0.00 to 100.00
width
V4 Soft Defocus 0.00 to 100.00
condition for
edge
Wipe Edge | Adjust the color of the wipe edge. V2 Lum Luminance 0.00 to 100.00 1I-12
Color V3 |Sat Saturation 0.00 to 100.00
V4 Hue Hue 359.99 to 0.00
DME Wipe | Set the DME wipe direction and DME Vi1 Modify Press the knob |- 1I-13
Adjust wipe pattern. to display the
You can also press the V1 knob to display [DME Wipe
the [DME Wipe Modify] menu (page Modify] menu
1I-18). V3 Direct DME wipe Norm (normal),
direction N/R (normal/
When the KEY next transition selection reverse), Rev
button is selected, 1101 to 1102 (Flip (reverse)
Tumble), 1251 (PinP), 1701 (Mosaic), V4 PtnNum DME wipe 1001 to 1008
and 1702 (Defocus) cannot be selected. pattern number | (Slide), 1021 to
1031 (Squeeze),
1041 to 1044
(Door), 1201 to
1208/1221 to
1224 (Frame In/
Out), 1101 to
1102 (Flip
Tumble), 1251
(PinP), 1701
(Mosaic), 1702
(Defocus)
Details on [Effect] Menu II- 1 5
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Menu item | Description Knob | Parameter | Meaning Setting range Reference
page
DME Wipe | Add a border around the DME pattern V2 Type DME wipe edge | Off, Border, II-14
Edge (border), and defocus the edge of an type S-Brdr (soft
added border (soft border). border)
V3 Width Adjusts border | 0.00 to 100.00
width (2.00)
V4 Soft Defocus 0.00 to 100.00
— condition for
—— edge
——— DME Wipe | Adjust the color of a DME wipe edge. V2 Lum Luminance 0.00 to 100.00 1I-14
Q Edge Color (14.63)
% V3 |Sat Saturation 0.00 to 100.00
N (50.09)
s V4 Hue Hue 359.99 to 0.00
2 (349.83)
¢ DME Wipe | Adjust the background color for the DME | V2 Lum Background 0.00 to 100.00 1I-14
g |Bkgd Color | wipe. color luminance
a V3 Sat Background 0.00 to 100.00
color saturation
V4 Hue Background 359.99 to 0.00
color hue
[Wipe Modify] Menu
Display the [Wipe Modify] menu by pressing the V1 knob while [Wipe Adjust] is selected.
Menu item | Description Knob | Parameter | Meaning Setting range Reference
page
Positioner | Turn the positioner for adjusting the wipe | V3 AutoCT Turns auto Off, On II-11
position on/off. center function
If you also select [On] with the V3 knob, on/off
the pattern will move from the location to V4 Pos Turns positioner Off, On
which the pattern was moved with the on/off
positioner to the center of the screen as a
result of the transition.
The patterns for which the positioner can
be used are as follows.
17,18, 21, 22, 23, and 24
Positioner | Adjust the wipe position. V2 Pos H Adjusts position |—200.00 to II-11
Adjust If you want to reset the setting value to in horizontal +200.00 (0.00) (A
“0.00,” press the V4 knob. direction negative value
moves the pattern
left, and a positive
value moves it
right)
V3 Pos V Adjusts position |—200.00 to
in vertical +200.00 (0.00) (A
direction negative value
moves the pattern
down, and a
positive value
moves it up)
V4 Center Resets setting |-
value to “0”
1I- 16 Details on [Effect] Menu
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Menu item | Description Knob | Parameter | Meaning Setting range Reference
page
Rotation Set the rotation method of a wipe pattern. | V4 Rotate Rotation type Off, Angle, II-11
Speed, Mag
(magnitude)
Rotation Set the parameters depending on the V2 Angle e Pattern —100.00 to 1I-11
Adjust rotation type selected in [Rotation]. inclination +100.00 (0.00)
* When [Angle] is selected: Set [Angle]. angle ([Angle])
* When [Speed] is selected: Set [Speed]. e Pattern
* When [Mag] is selected: Set [Angle] inclination
and [Mag]. angle when
transition
About setting values starts ([Mag])
Angle: —100.00 corresponds to the state [y/3 Mag Amount of —200.00 to
in which the pattern is rotated once rotation during | +200.00 (0.00)
counterclockwise, and +100.00 to transition
trg?af;zti:;:'g'ggkw;ga(t)t%g] IS V4 Speed Pattern rotation |-100.00 to
o speed +100.00 (0.00)
corresponds to a non-rotation state.
Mag: —200.00 rotates the pattern twice
counterclockwise, and +200.00
rotates the pattern twice clockwise.
0.00 does not rotate the pattern.
Speed: —100.00 is the speed of one
counterclockwise rotation per
second, and +100.00 is the speed of
one clockwise rotation per second.
0.00 corresponds to a stationary
state.
Aspect Change the aspect ratio of a wipe V3 Aspect Turns aspect Off, On 1I-12
pattern. Setting the aspect ratio to a adjustment on/
negative value stretches the pattern off
vertically to make it longer in the vertical |v4 Ratio Adjusts aspect |—100.00 to
direction, and setting the aspect ratioto a ratio +100.00 (0.00)
positive value stretches the pattern
horizontally to make it longer in the
horizontal direction.
Multi Turn the multi function for replicating wipe | V4 Multi Turns multi Off, On 1I-12
patterns on/off. function on/off
Multi The same pattern can be placed up to 63 | V2 H Mult Number of 1t0 63 II-12
Adjust times either horizontally or vertically, orin patterns to place
both directions. in horizontal
direction
V3 V Mult Number of 110 63
patterns to place
in vertical
direction
V4 InvTyp Pattern 1to4
placement
method
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[DME Wipe Modify] Menu

Display the [DME Wipe Modify] menu by pressing the V1 knob while [DME Wipe Adjust] is selected.

cutting bottom
portion of image

Menu item | Description Knob | Parameter | Meaning Setting range Reference

page

Positioner | Turn the positioner for adjusting the V4 Pos Turns positioner | Off, On II-13
DME wipe position on/off. on/off
The patterns for which the positioner
can be used are as follows.

1031, 1201 to 1208, 1221 to 1224, and
1251

Positioner | Adjust the DME wipe position. V2 Pos H Adjusts position |—200.00 to +200.00 |II-13

Adjust If you want to reset the setting value to in horizontal (0.00) (A negative
“0.00,” press the V4 knob. direction value moves the

pattern left, and a
positive value moves
it right)

V3 Pos V Adjusts position |—200.00 to +200.00
in vertical (0.00) (A negative
direction value moves the

pattern down, and a
positive value moves
it up)

V4 Center Resets setting -
value to “0”

Size You can adjust the size of the V3 Size Turns size Off, On 1I-13
sub-screen when you use the 1201 to adjustment on/off
1208 (Frame In/Out), 1221 to 1224 ! Param Adjusts size 0.00 to 200.00
(Frame In/Out), and 1251 (PinP) DME (100.00)
wipe patterns.

Notes on setting values

Param: Set the enlarge/reduce ratio
as a percentage. The 100.00
setting is equal to the size of the
input image.

Crop H Turn the crop function on/off, and set | V2 Crop Turns crop on/off | Off, On II-13
the left and right positions used when |v3 Left Position for -100.00 to +100.00
cropping unnecessary portions of an cutting left
image. portion of image

V4 Right Position for —100.00 to +100.00
cutting right
portion of image

Crop V Set the action performed when a V2 Trans Action when Cut, Last5%, Linear |1I-13
transition is executed, and set the top transition
and bottom positions used when executed
cropping unnecessary portionsofan  {v3 [ Top Position for —-100.00 to +100.00
image. cutting top

portion of image
V4 Bottom Position for =100.00 to +100.00

i)

The crop function is not available in the following cases.

* When the 1701 (Mosaic) or 1702 (Defocus) effect pattern is selected
* When the KEY next transition selection button is selected

Details on [Effect] Menu
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Setting Keys

A key is a function for cutting out the background image
and then inserting an image or text in that portion. The
signal for cutting out the background is called a key
source, the signal for filling the cutout portion is called a
key fill, and the block for processing a key is called a
keyer.

This section describes how to make detailed adjustments
for keys.

With this unit, you can make the following settings for

keys.

* Basic Operations for Keys (page 1I-19)

* Setting Key Transitions (page 11-20)

* Selecting the Pattern and Direction for Key Wipes (page
11-20)

* Making Detailed Adjustments to Key Wipe Patterns
(page 11-20)

* Setting Key DME Wipes (page 11-20)

* Making Detailed Adjustments to Key DME Wipe
Patterns (page 11-21)

*» Selecting Key Types (page 11-21)

* Making Detailed Adjustments to the Luminance Key
(page 11-21)

* Making Detailed Adjustments to the Linear Key (page
1I-21)

* Making Detailed Adjustments to the Chroma Key (page
1I-21)

o Setting the Key Fill and Key Source (page 1I-21)

* Setting a Mask for a Key (page 1I-22)

* Adding an Edge to a Key (page 11-22)

* Adjusting the Size and Position of the Key (page 11-22)

For the basic operating procedures of the luminance key and chroma key, see
“Composing Images with Keys” (9 Basic Operation).

Make the key and the key transition settings in the [Key]
menu.

For details on the [Key] menu item, see “Details on [Key] Menu” (page
11-23).

Tip
In 3D mode, the [Key] menu is not displayed.

Download from Www.Somanuals.com. All Manuals Search And Download.

Basic Operations for Keys

Use the following procedure to perform basic operations
for keys.

| Material selection |

|Transition configuration |

| Key configuration |

|Transition execution |

Depending on where you want to perform the key

transition, perform one of the following two variations for

basic key operations.

¢ Effect transition (select KEY next transition button)
(page 11-19)

» Key transition (page 11-20)

Effect transition

Material selection

‘ Press the KEY bus delegation button. ‘

|

‘ Select the video for program output. ‘

l

Select the key material (i.e., the image to be
superimposed on the program video output).

Transition configuration

‘ Press the KEY next transition selection button to light it. ‘

|

‘ Press the MIX button or EFF button. ‘
!

‘ Set the transition type for the effect transition.”) ‘

|

Select the pattern and direction for the wipe or DME wipe
if necessary.")

1) Use the [Effect] menu.

Key configuration 3

‘ Select the key type. ‘

|

‘ Make detailed adjustments to the key if necessary. ‘

Setting Keys
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Transition execution &4

Execute the transition using the fader lever, CUT button,
or AUTO TRANS button.

Key transition

Material selection

| Press the KEY bus delegation button. |

|

| Select the video for program output. |

|

Select the key material (i.e., the image to be
superimposed on the program video output).

Transition configuration

Set the transition type for the key transition.” |

|

Select the pattern and direction for the key wipe or key
DME wipe if necessary."

1) Use the [Key] menu.

Key configuration 3

| Select the key type. |

|

| Make detailed adjustments to the key if necessary. |

Transition execution &

| Execute the transition using the KEY TRANS button. |

Setting Key Transitions

Set the key transition rate and key transition type for when

a key transition is performed.

You can select any of the following transition types.

Cut: Quickly insert (cut in) or remove (cut out) the key.

Mix: Gradually insert (fade in) or remove (fade out) the
key.

Wipe: Use the wipe to cut out the background and then
embed a key.

DME (Digital Multi Effects): Use a DME effect and
apply the same effect as the DME wipe to the key (key
DME wipe).

Settings menu: [Key Transition] (page II-23)

Setting Keys

Selecting the Pattern and Direction
for Key Wipes

You can cut out the background from a wipe pattern
selected for a key transition and then embed a key.

Settings menu: [Key Wipe Modify] (page 1I-24)

For details on the wipe directions, see “Selecting the Pattern and Direction
for Wipes” (page II-11).

For details on the wipe pattern numbers, see “Effect Pattern List” (9 Basic
Operation).

Making Detailed Adjustments to Key
Wipe Patterns

You can set the position of a wipe pattern, and apply
various variations and modifiers in [Key Wipe].

To display the [Key Wipe] menu
Display the [Key] menu, turn the V1 knob to select [Key
Wipe], and press this knob.

The setting items in the [Key Wipe Modify] menu are the same as those of
[Wipe Modify] in the [Effect] menu. For details on the setting items, see the
corresponding sections of “Making Detailed Adjustments to Wipe Patterns”
(page 1I-11).

Setting Key DME Wipes

For a key, you can make the same settings as with DME
wipe.

Settings menu: [Key DME Wipe] (page 11-24)

For details on the DME wipe directions, see “Selecting the Pattern and
Direction for Wipes” (page II-11).

For details on the wipe pattern numbers, see “Effect Pattern List” (9 Basic
Operation).
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Making Detailed Adjustments to Key
DME Wipe Patterns

You can adjust the position of a key DME wipe pattern and
adjust the size of a sub-screen for during Frame In/Out and
PinP in the [Key DME Wipe Modify] menu.

To display the [Key DME Wipe Modify] menu
Display the [Key] menu, turn the V1 knob to select [Key
DME Wipe], and press this knob.

The setting items that can be configured in the [Key DME Wipe Modify]
menu are the same as those of the [DME Wipe Modify] menu for a DME wipe
(except for the crop item). See the corresponding sections of “Making
Detailed Adjustments to DME Wipe Patterns” (page 1I-13).

Selecting Key Types

Select the key types to cut off the images.

You can select any of the following key types.

Lum (luminance key) / Lin (linear key): Use these
when inserting titles or logos onto the image.
Use brightness signals such as those for black and
white text as the key source.

Tip
Linear keys have a reduced variability in gain that

allows more precise adjustment when compared to
luminance keys.

Chr (chroma key): Use this when combining images of
people with a background image, for example.
Create the key source from a particular color within
the input image.

Settings menu: [Key Type Select] (page 1I-23)

Making Detailed Adjustments to the
Luminance Key

You can make detailed adjustments for the cutout
condition of the background, the key density, and other
settings for composing video with luminance keys.

Settings menu: [Lum Key Adjust (1/2)] (page 1I-23),
[Lum Key Adjust (2/2)] (page 1I-23), [Lum Key
Mode] (page 1I-23)
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Making Detailed Adjustments to the
Linear Key

You can make detailed adjustments for the cutout
condition of the background, the key density, and other
settings for composing video with linear keys.

Settings menu: [Lin Key Adjust (1/2)] (page II-23),
[Lin Key Adjust (2/2)] (page II-24), [Lin Key Mode]
(page 11-24)

Making Detailed Adjustments to the
Chroma Key

When, for example, you want to fine-tune the results of
automatic chroma key adjustment, you can specify each
chroma key setting manually in the [Manual Chromakey]
menu. You can also replace background colors (typically
blue) that seep into the outline portions of the video being
combined (such as into a subject’s hair) with colors such
as gray to make them less conspicuous.

For details on automatic chroma key adjustment, see “Composing Images
with Chroma Keys” (< Basic Operation).

To display the [Manual Chromakey] menu
Display the [Key] menu, turn the V1 knob to select
[Chromakey Manual Adj], and press this knob.

For details on the [Manual Chromakey] menu, see “[Manual Chromakey]
Menu” (page I1-28).

Setting the Key Fill and Key Source

Select the signal to use for the key fill and the signal
selection mode to use for the key source.

Settings menu: [Key Fill/Src Select] (page I1I-23), [Key
Fill Mat Adjust] (page 1I-23)

Key source selection modes

Self: Selects the signal of the key source bus as the key
source.

If the chroma key is selected as the key type, select
[Self].

Auto: Automatically selects the signal of the key fill bus
and the paired signal assigned to a cross point button
as the key source.

Split: Allows you to select the key source bus signal
separately from the key fill bus signal.

For details on selection, see “Selecting the key fill and key source
separately” (9 Basic Operation).

Setting Keys
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The key fill and key source pairs selected when [Auto]
is selected are as follows.

Key fill Key source

Frame memory video Frame memory key
Black video White video?

Signals other than the above | Same signal as key fill

1) If you perform keying with white video as the key source, the key fill
video will fill the entire screen.

Key fill selection modes

Bus: Signal selected with a cross point button

Matte: Signal generated with the color matte generator
within the unit (you can adjust the color under [Key
Fill Mat Adjust])

Setting a Mask for a Key

Key mask is a function for masking a portion of the key
signal.

Background

The inside of the Mask Portion
mask will be used

as the key.

Settings menu: [Key Mask] (page I1-25)

Adding an Edge to a Key

You can add a border to the edge of the key (border) and
defocus the edge of the key (soft).

When you add a border to a key, the positions of the key
fill and key source will move downward.

Setting Keys

Setting modifiers for the key edge

Turn drop mode on or off and set the type of modifier.

* If you turn drop mode on, the position of the key fill and
key source will move downward, regardless of whether
borders are added. If you do not want to move the
position of the key in response to whether key border is
turned on or off, turn drop mode on.

* You can select any of the following modifiers.

Border

Normal

Normal: The state in which a border around the key is
not added.

Border: Allows you to add a border around the key and
adjust the width and border density.

Settings menu: [Key Edge Type] (page II-25), [Border
Adjust] (page 1I-25), [Border Matte Adjust] (page
11-25), [Key Soft Edge] (page 1I-25)

Adjusting the Size and Position of
the Key

Under the [Resizer] menu, you can apply effects, such as
reducing, enlarging, moving, and changing the aspect
ratio, to the created key portion in a similar manner as
DME (resize function).

* If a resize effect is applied to the key, there will be a
one-frame delay in the image.

* Of the DME wipe, key DME wipe, and resize functions,
only one can be used at any one time.

To enable the resize function

Display the [Key] menu, turn the V1 knob to select
[Resizer], and turn the V4 knob to select [On]. (See page
11-23)

To display the [Resizer] menu
Display the [Key] menu, turn the V1 knob to select
[Resizer], and press this knob.

For details on the [Resizer] menu, see “[Resizer] Menu” (page 11-26).
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Details on [Key] Menu

[Key] Menu
Press the KEY button in the menu control block to display the [Key] menu.
Menu item | Description Knob | Parameter | Meaning Setting range | Reference —
page —
Key Set the transition rate and transition type | V3 Rate Transition rate 1 to 999 (30) 1I-20 o
Transition used when key transition is executed with | y/4 Type Transition type | Cut, Mix, Wipe, _ng
the KEY TRANS button. DME 5]
Key Type Select the key type to cut off the images. | V4 Type Key type Lum 1I-21 :
Select (Luminance g
key), Lin (Linear 3,
key), Chr =
(Chromakey) =
Resizer Select whether to use the resize function | V1 Select Press the knob |- 11-22 @
that applies effects, such as reducing, to display the
enlarging, moving, and changing the [Resizer] menu
aspect ratio, to the created key portion in |y/4 Resize Turns resizer Off, On
a similar manner as DME. function on/off
You can also press the V1 knob to display
the [Resizer] menu (page I1-26).
Key Fill/Src | Select the signal to use for the key filland | V3 Source Selection mode | Self, Auto, Split |II-21
Select the signal selection mode to use for the of key source
key source. V4 Fill Signal to use as | Bus, Matte
key fill
Key Fill Mat | Adjust the color of the key fill matte. V2 Lum Color matte 0.00 to 100.00 |II-21
Adjust luminance
V3 Sat Color matte 0.00 to 100.00
saturation
V4 Hue Color matte hue |359.99 to 0.00
Lum Key Adjust the background cutout condition | V3 Clip Cutout condition |+109.59t0—-7.31 |-
Adjust (1/2) | and outline sharpness of the luminance for background | (0.00)
key. (clip value)
V4 Gain Outline —100.00 to
sharpness (gain |+100.00 (0.00)
value)
Lum Key Adjust the luminance key density. V4 Dens Key density 0 to 100.00 -
Adjust (2/2)
Lum Key Turn the clean mode for the luminance V4 Clean Turns clean Off, On -
Mode key on/off. When the clean mode is on, mode on/off
the key source does not affect the key fill,
which is added unchanged to the
background.
Clean mode is effective when you are
using signals consisting of a paired key
fill and key source, as with a character
generator.
Lin Key Adjust the background cutout condition | V3 Clip Cutout condition |+109.59t0-7.31 |-
Adjust (1/2) | and outline sharpness of the linear key. for background | (0.00)
(clip value)
V4 Gain Outline —100.00 to
sharpness (gain |+100.00 (0.00)
value)
Details on [Key] Menu H—23
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Menu item | Description Knob | Parameter | Meaning Setting range | Reference
page
Lin Key Adjust the linear key density. V4 Dens Key density 0 to 100.00 -
Adjust (2/2)
Lin Key Turn the clean mode for the linear key on/ | V4 Clean Turns clean Off, On -
Mode off. When the clean mode is on, the key mode on/off
source does not affect the key fill, which
is added unchanged to the background.
Clean mode is effective when you are
using signals consisting of a paired key
fill and key source, as with a character
generator.
Chromakey | Display the [Auto Chromakey] menu VA Auto Press the knob |- Operating
Auto Adj (page I1-27) that allows you to specify a to display the Instructions
part of the foreground video (e.g., the [Auto (Basic
blue background color) and use it as a Chromakey] Operation)
reference for automatically creating the menu
chroma key image.
Chromakey | Display the [Manual Chromakey] menu | V1 Manual Press the knob |- 1121
Manual Adj | (page 11-28) for making detailed to display the
adjustments to the chroma key. [Manual
Chromakey]
menu
Key Invert | Invert white and black of the key source. |V4 Invert Turns key source | Off, On -
inversion on/off
Key Wipe | Set the key wipe direction and key wipe | V1 Modify Press the knob |- 11-20
pattern. to display the
You can also press the V1 knob to display [Key Wipe
the [Key Wipe Modify] menu (page I1-29). Modify] menu
V3 Direct Key wipe Norm (normal), |II-20
direction N/R (normal/
reverse), Rev
(reverse)
V4 PtnNum Key wipe pattern |1 to 24
number
Key Wipe | Defocus the edge of a key wipe pattern | V3 Soft Turns soft edge | Off, On -
Edge (soft edge). on/off
V4 Param Defocus 0.00 to 100.00
condition for
edge
Key DME Set the key DME wipe direction and key | V1 Modify Press the knob |- 11-20
Wipe DME wipe pattern. to display the
You can also press the V1 knob to display [Key DME Wipe
the [Key DME Wipe Modify] menu (page Modify] menu
11-30). V3 Direct Key DME wipe | Norm (normal),
direction N/R (normal/
reverse), Rev
(reverse)
V4 PtnNum Key DME wipe | 1001 to 1008

pattern number

(Slide), 1021 to
1031 (Squeeze),
1041 to 1044
(Door), 1201 to
1208, 1221 to
1224 (Frame In/
Out)

Details on [Key] Menu
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Menu item | Description Knob | Parameter | Meaning Setting range | Reference
page
Key Mask | Set the key mask function for masking a | V3 Mask Turns mask Off, On 11-22
portion of a key signal. function on/off
V4 Invert On/off of mask | Off, On
inversion
Key Mask | Specify the left and right positions of the | V3 Left Position of left —100.00 to 11-22
Box H mask box. side +100.00
(-50.00)
V4 Right Position of right |—100.00 to
side +100.00
(+50.00)
Key Mask | Specify the top and bottom positions of V3 Top Position of top —100.00 to 11-22
Box V the mask box. side +100.00
(+50.00)
V4 Bottom Position of —100.00 to
bottom side +100.00
(-50.00)
Key Edge | Turn drop mode on or off and set modifier | V3 Drop Turns drop mode | Off, On 11-22
Type for the key edge. on/off
V4 Type Key edge type Norm (normal),
Border
Border Adjust the density and width of the V3 Dens Border density | 0.00 to 100.00 |II-22
Adjust border. V4 | Width Border width 0.00 to 4.00
Border Adjust the color of the border matte. V2 Lum Border matte 0.00 to 100.00 |II-22
Matte luminance
Adjust V3 Sat Border matte 0.00 to 100.00
saturation
V4 Hue Border matte 359.99 to 0.00
hue
Key Soft Defocus the edge of the key (soft edge). | V3 Soft Turns soft edge | Off, On 11-22
Edge Turn on the key edge and adjust the on/off
defocus condition of the edge. ! Param Defocus 0.00 to 100.00
condition for
edge
Fine Key Turn the fine key function for fine-tuning | V4 Fine Turns fine key Off, On -
the position of the key signal edge on/off. function on/off
Fine Key When the fine key function is on, V3 Left Position of left —-2.00to +2.00 |-
Adjust H fine-tune the left and right positions of the side (0.00)
key signal edge. V4 Right Position of right |-2.00 to +2.00
side (0.00)
Fine Key When the fine key function is on, V3 Top Position of top —-2.00to +2.00 |-
Adjust V fine-tune the top and bottom positions of side (0.00)
the key signal edge. V4  |Bottom Position of -2.00 to +2.00
bottom side (0.00)
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[Resizer] Menu

Display the [Resizer] menu by pressing the V1 knob while [Resizer] (page 1I-23) is selected.

ratio

Mode] is [Off],
0.00 to 2.00
(1.00)

¢ When[Rotation
Mode] is [On],
fixed at 1.00
(adjustment is
disabled)

Menu item | Description Knob | Parameter | Meaning Setting range Reference
page
Rotation Select whether the resizer function V3 Axis Selects rotation | X, Y -
Mode moves in 2D or 3D. axis for 3D
transform
Depending on this setting, the V4 |Enable Switches Off (2D
adjustment ranges for the following between 2D transform), On
[Location], [Aspect], and [Rotation] transformand | (3D transform)
settings will vary. 3D transform
Location Reduce/enlarge and move the key. V2 Loc X Moves key in —100.00 to -
horizontal +100.00 (0.00)
* The setting range for the horizontal direction
direction differs between HD/SD 4:3  |V3  |LocY Moves keyin |+ When[Rotation
and SD 16:9. vertical direction Mode] is [Off],
* The setting range for the vertical -100.00 to
direction differs between HD/SD 4:3, +100.00 (0.00)
SD 16:9, and 3D. ¢ When[Rotation
Mode] is [On],
—9.00 to 9.00
(0.00)
V4 Size Reduces/ * When[Rotation
enlarges key Mode] is [Off],
0.00 to 100.00
(1.00)
¢ When[Rotation
Mode] is [On],
0.00 to 1.00
Aspect Change the aspect ratio of a key. V2 Asp X Changes size in |* When[Rotation |—
horizontal Mode] is [Off],
direction 0.00 to 100.00
(1.00)
* When[Rotation
Mode] is [On],
fixed at 1.00
(adjustment is
disabled)
V3 Asp Y Changes size in |* When[Rotation
vertical direction Mode] is [Off],
0.00 to 100.00
(1.00)
¢ When[Rotation
Mode] is [On],
fixed at 1.00
(adjustment is
disabled)
V4 Ratio Changes aspect |* When[Rotation

Details on [Key] Menu
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Menu item

Description

Knob

Parameter

Meaning

Setting range

Reference
page

Rotation

Rotate the key and adjust perspective.

A

Rot X

Amount of
X-axis rotation

¢ When[Rotation
Mode] is [Off],
fixed at 0.00
(adjustment is
disabled)

¢ When[Rotation
Mode] is [On],
—100.00 to
+100.00 (0.00)

V3

Rot Y

Amount of Y-axis
rotation

¢ When[Rotation
Mode] is [Off],
fixed at 0.00
(adjustment is
disabled)

¢ When[Rotation
Mode] is [On],
—100.00 to
+100.00 (0.00)

V4

Pers

Perspective

* When[Rotation
Mode] is [Off],
fixed at 1.00
(adjustment is
disabled)

¢ When[Rotation
Mode] is [On],
0.00to 1.00

[Auto Chromakey] Menu

Display the [Auto Chromakey] menu by pressing the V1 knob while [Chromakey Auto Adj] (page 11-24) is selected.

Menu item | Description Knob | Parameter | Meaning Setting range Reference
page

Sample Display the sample mark (i.e., white box) | V4 Mark Turns sample Off, On Basic
Mark for specifying the cutout color (i.e., color mark display on/ Operation

to be used as the reference of chroma off

key).
Sample Adjust the size and position of the sample | V2 Pos H Position in —100.00 to Basic
Mark mark. horizontal +100.00 (0.00) Operation
Adjust direction

Depending on the size setting, the setting | V3  |Pos V Position in —100.00 to

ranges for the horizontal and vertical vertical direction | +100.00 (0.00)

positions will vary. V4 Size Size 1.00 to 100.00

(25.00)

Auto Execute auto chroma key. V4 Start Press the knob |- Basic
Adjust When you press the V4 knob, auto to execute auto Operation
Execute chroma key is executed using the color chroma key.

specified with the sample mark as a
reference, and the composed image is
output.
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[Manual Chromakey] Menu

Display the [Manual Chromakey] menu by pressing the V1 knob while [Chromakey Manual Adj] (page 1I-24) is selected.

Menu item | Description Knob | Parameter | Meaning Setting range Reference
page
Chr Key Adjust the background cutout condition, |V2 Hue Hue of color you |359.99 to 0.00 -
Adjust outline sharpness, and other settings. want to cut out | (0.00)
(1/2) V3 Clip Saturation of 0.00 to 100.00
color you want to | (50.00)
cut out
V4 Gain Outline 0.00 to 100.00
sharpness (gain | (0.00)
value)
Chr Key Adjust the chroma key density. V4 Dens Key density 0 to 100.00 -
Adjust
(2/2)
Color Turn on/off the color cancel function that | V4 Cancel Turns color Off, On -
Cancel removes background colors (e.g., blue cancel function
screen) that seep into the outline areas of on/off
the subject of the video being combined.
Color Adjust the color that will be removed via | V2 Lum Brightness offset | 0.00 to 100.00 -
Cancel color cancel. of the color to be
Adjust canceled
V3 Sat Saturation of 0.00 to 100.00
color to be
canceled
V4 Hue Hue of colorto | 359.99 to 0.00
be canceled
Chr Key Turn on/off the window function that V4 Window Turns window Off, On -
Window allows you to adjust the detection range function on/off
for the color you want to remove.
When the window function is off, image
adjustment is made within the range of
the default values.
Chr Key Adjust the window shape. V3 Crop Position for 100.00 to 0.00 -
Window cropping the top | (75.00)
Adj of the window
V4 Angle Angle at which | 180.00 to 0.00
the window is (180.00)
opened

Details on [Key] Menu
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[Key Wipe Modify] Menu

Display the [Key Wipe Modify] menu by pressing the V1 knob while [Key Wipe] (page 1I-24) is selected.

Menu item | Description Knob | Parameter | Meaning Setting range Reference
page
Positioner | Turn the positioner for adjusting the key | V3 AutoCT Turns auto Off, On -
wipe position on/off. center function
If you also select [On] with the V3 knob, on/off
the pattern will move from the location to [y4 Pos Turns positioner | Off, On
which the pattern was moved with the on/off
positioner to the center of the screen as a
result of the transition.
The patterns for which the positioner can
be used are as follows.
17,18, 21, 22, 23, and 24
Positioner | Adjust the key wipe position. If you want |V2 Pos H Adjusts position | —200.00 to +200.00 | —
Adjust to reset the setting value to “0.00,” press in horizontal (0.00)
the V4 knob. direction
V3 Pos V Adjusts position |—200.00 to +200.00
Notes on setting values in vertical (0.00)
Pos H: Negative values adjust the direction
position to the left, positive values to va Center Resets setting |~
the right. value to “0”
Pos V: Negative values adjust the
position to the bottom, positive
values to the top.
Rotation Set the rotation method of a key wipe V4 Rotate Rotation type Off, Angle, Speed, |-
pattern. Mag (magnitude)
Rotation Set the parameters depending on the V2 Angle e Pattern —100.00 to +100.00 |1I-11
Adjust rotation type selected in [Rotation]. inclination (0.00)
* When [Angle] is selected: Set [Angle]. angle
* When [Speed] is selected: Set [Speed]. ([Angle])
* When [Mag] is selected: Set [Angle] e Pattern
and [Mag]. inclination
angle when
About setting values transition
Angle: —100.00 corresponds to the state starts ([Mag])
in which the pattern is rotated once V3 Mag Amount of ~200.00 to +200.00
counterclockwise, and +100.00 to rotation during | (0.00)
the state in which the pattern is transition
gz)trar;%g:g: %O:m:ﬁé%ggn state. V4 Speed Pattern rotation |—100.00 to +100.00
Mag: —200.00 rotates the pattern twice speed (0.00)
counterclockwise, and +200.00
rotates the pattern twice clockwise.
0.00 does not rotate the pattern.
Speed: —100.00 is the speed of one
counterclockwise rotation per
second, and +100.00 is the speed of
one clockwise rotation per second.
0.00 corresponds to a stationary
state.
Details on [Key] Menu
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Menu item | Description Knob | Parameter | Meaning Setting range Reference
page
Aspect Change the aspect ratio of a key wipe V3 Aspect Turns aspect Off, On I-12
pattern. Setting the aspect ratio to a adjustment on/
negative value stretches the pattern off
vertically to make it longer in the vertical |v4 | Ratio Adjusts aspect |—100.00 to +100.00
direction, and setting the aspect ratioto a ratio (0.00)
positive value stretches the pattern
horizontally to make it longer in the
horizontal direction.
Multi Turn the multi function for replicating key | V4 Multi Turns multi Off, On I-12
wipe patterns on/off. function on/off
Multi The same pattern can be placed up to 63 | V2 H Mult Number of 11063 II-12
Adjust times either horizontally or vertically, orin patterns to
both directions. place in
horizontal
direction
V3 V Mult Number of 110 63
patterns to
place in vertical
direction
V4 InvTyp Pattern 1t04
placement
method

[Key DME Wipe Modify] Menu

Display the [Key DME Wipe Modify] menu by pressing the V1 knob while [Key DME Wipe] (page 1I-24) is selected.

Notes on setting values

Param: Set the enlarge/reduce ratio as a
percentage. The 100.00 setting is
equal to the size of the input image.

Menu item | Description Knob | Parameter | Meaning Setting range Reference
page
Positioner | Turn the positioner for adjusting the key | V4 Pos Turns positioner | Off, On -
DME wipe position on/off. on/off
The positioner can be used for the
following patterns.
1031, 1201 to 1208, and 1221 to
1224
Positioner | Adjust the key DME wipe position. If you |V2 Pos H Adjusts position |—200.00 to -
Adjust want to reset the setting value to “0.00,” in horizontal +200.00 (0.00)
press the V4 knob. direction
] V3 Pos V Adjusts position |—200.00 to
Notes on setting values in vertical +200.00 (0.00)
Pos H: Negative values adjust the direction
posn.lon to the left, positive values to Va Center Resets setting —
the right. value to “0”
Pos V: Negative values adjust the
position to the bottom, positive
values to the top.
Size Adjusts the size of the sub-screen when |V3 Size Turns size Off, On -
you use the 1201 to 1208 (Frame In/Out) adjustment on/
and 1221 to 1224 (Frame In/Out) key off
DME wipe patterns. V4 | Param Adjusts size 0.00 to 200.00
(100.00)

Details on [Key] Menu
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Audio Mixing

Chapter

Overview

You can adjust the audio input in detail, set the audio levels, and specify the connectors to use for audio output for each
audio channel.

Adjust and set the audio from the [Audio Channel] menu for each audio channel.

To display the [Audio Channel] menu

Press the ACCESS/PFL button in the same column as the channel fader assigned to the audio channel you want to adjust.

ACCESS/PFL buttons

MONITOR « ...@ .
SEL
o 70

MONITOR LEVEL

0000000000000000 O
000000
8 & 83 o %

For details on assigning an input signal to each channel fader, see “Assigning Audio Input Signals to the Channel Faders” (9 Basic Operation).

Details on [Audio Channel] Menu

Menu item |Description Knob | Parameter | Meaning Setting range | Reference
page
Input Trim Adjust the audio input signal levels. You |V4 Level Adjusts input -15dBto -
can individually adjust the assigned level +15 dB (0 dB)
channels of the audio signals input to this
unit.
Filter Cut high frequency and low frequency. V3 L Cut Cuts low Off, On -
Use these settings to suppress noise, frequency
etc. (100 Hz or less)
V4 H Cut Cuts high Off, On
frequency (8 kHz
or more)

Download from Www.Somanuals.com. All Manuals Search And DovaX%re\alclfw / Details on [Audio Channel] Menu
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Menu item |Description Knob | Parameter | Meaning Setting range | Reference
page
Equalizer Use the equalizer function to adjust the | V2 EQH Turns audio Off, On -
High audio quality by setting the quality
high-frequency band. adjustment of
high-frequency
band on/off

V3 Freq Center frequency [1.30 k to
of high-frequency | 17.40 k (4.75 k)
band (kHz)

V4 Level Level of -15dB to
high-frequency +15 dB (0 dB)
band

Equalizer Use the equalizer function to adjust the | V2 EQM Turns audio Off, On -
Mid audio quality by setting the quality
middle-frequency band. adjustment of
middle-frequency
band on/off

V3 Freq Center frequency |260.0 k to
of 6.40 k (1.28 k)
middle-frequency
band (kHz)

V4 Level Level of -15dB to
middle-frequency |+15 dB (0 dB)
band

Equalizer Use the equalizer function to adjust the | V2 EQL Turns audio Off, On -
Low audio quality by setting the low-frequency quality
band. adjustment of
low-frequency
band on/off

V3 Freq Center frequency |31.0 to 420.0
of low-frequency |(114.1)
band (Hz)

V4 Level Level of -15dB to
low-frequency +15 dB (0 dB)
band

Limiter/ Set the limiter or compressor when V3 Type Selects method | Off, Lim -
Compressor | inputting audio with large level for compressing | (limiter), Comp
differences. audio (compressor)
* The limiter restricts the peak V4 [Thresh  [Levelatwhich |0 dBto—60 dB
components of an audio signal with the limiter or (-20 dB)
large level differences. It also . compressortakes
compresses the sound exceeding a effect (threshold)
certain threshold volume, thus
preventing excess outputs.
* The compressor gently compresses
the level of audio at and above the
threshold level, thus smoothing out an
audio signal with large level
differences.
Pan Adjust the audio left and right balance. V4 Bal Adjusts leftand |15Lto 15R (0) |-

right balance

Details on [Audio Channel] Menu
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Menu item |Description Knob | Parameter | Meaning Setting range | Reference
page
PGM Assign | Output the audio from the PGM OUT V4 PGM Turns output of | Off, On -
Connector. the PGM OUT
connector on/off
The output level of the audio output from
the PGM OUT connector can be adjusted
with the program fader in the audio
control block.
MIX OUT Output the audio from the MIX OUT V4 MIX Turns output of | Off, On -
Assign Connector. MIX OUT
connector on/off
AUX1 OUT | Output the audio from the AUX OUT 1 V2 AUX1 Turns output of Off, On -
Assign connector. AUX OUT 1
connector on/off
About the state of the audio that is V3 Level Adjusts audio _8to+10 dB
output o level (0 dB)
Pre: Outputs the audio prior to level
control with the audio channel fader. | V4 Type State of audio Pre, Post
Post: Outputs the audio in the state in that is output
which all of the adjustments except
pan have been applied to the audio
signal.
AUX2 OUT | Output the audio from the AUX OUT 2 V2 AUX2 Turns output of Off, On -
Assign connector. AUX OUT 2
connector on/off
About the state of the audio that is V3 Level Adjusts audio 810 +10 dB
output o level (0 dB)
Pre: Outputs the audio prior to level
control with the audio channel fader. | V4 Type State of audio Pre, Post

Post: Outputs the audio in the state in
which all of the adjustments except
pan have been applied to the audio
signal.

that is output
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Input Image Freezing and

Frame Memory

Overview

Input freeze is a function that allows you to freeze images
from individual input signals.

Frame memory is a function that allows you to freeze
images and then write it to the memory of the unit so that
you can use it as input material.

Images that are stored in frame memory can be used as the
video input signals (FM) of the cross point buttons (PGM
buttons and PST/KEY buttons).

Tip

Input freeze and frame memory are not available in 3D
mode (the [Frame Memory] menu is not displayed).

Overview / Freezing Input Images

Chapter

Freezing Input Images

1 Press the FM button in the menu control block to
display the [Frame Memory] menu, and turn the V1
knob to select [Input Freeze].

Turn the V3 knob to select the input signal, turn the V4

knob to select [On], and press the V4 knob at the
timing you want to freeze.

The input image is frozen.

[Tip |

If you want to freeze an image again, select [Off],
press the V4 knob, and then select [On] again.

Knob |Parameter | Meaning Setting range
V3 Input Selects input SDI1, SDI2,
signal SDI3, SDI4,
DVI, H/V1,
H/V2, H/V3
V4 Freeze Turns freeze on/ | Off, On
off
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Selecting Frame Memory
for Use as Frame Memory
Video (FM)

Display the [Frame Memory] menu, turn the V1 knob to
select [Select], and turn the V4 knob to select the frame
memory to which the image you want to use as the frame
memory video is saved.

Frame Memory 1 to 12 are indicated as “FM1,” “FM2,” ...
“FM12.”

Knob |Parameter | Meaning Setting range
V4 FM Selects the frame FM1, FM2, FM3,
memory to be used | FM4, FM5, FM6,
as frame memory FM7, FM8, FM9,
video (FM) FM10, FM11,
FM12

Saving Images to Frame
Memory

Select the frame memory to which to save (Frame Memory
1 to 12), select the input signal to be used as the source, and
then freeze the input image to write it to memory.

1 Display the [Frame Memory] menu, turn the V1 knob
to select [Frame Memory Freeze], and then press the
knob.

The [Frame Memory Freeze] menu appears.

2 Turn the V1 knob to select the frame memory to which
to save the image ([Frame Memory 1] to [Frame
Memory 12]), turn V2 and V3 knobs to select the
source images, turn the V4 knob to select [On], and
press the V4 knob.

Knob |Parameter | Meaning Setting range
V2 SrcV Selects video |Black, SDI1,
source image |SDI2, SDI3,
SDI4, DVI, H/VA,
H/V2, H/V3,
ColBg, PGM,
Aux1, Aux2
V3 Src K Selects key Black, SDI1,
source image |SDI2, SDI3,
SDI4, DVI, H/VA1,
H/V2, H/V3,
ColBg, PGM,
Aux1, Aux2
V4 Store Saves input Off, On
image

The input image is saved to memory.

Tips

* If the [Store] parameter is set to [Off], the input
video of the frame memory is output.

 If [Src K] is set to [Black], an all white signal is
assigned to the key source image.

3 Press the FM menu selection button to exit the [Frame
Memory Freeze] menu.

The frame memory ([Frame Memory 1] to [Frame
Memory 12]) selected with the V1 knob in the [Frame
Memory Freeze] menu will be automatically selected to
the FM of the video input signal, and this will be reflected
in the selection status of [Select] in the [Frame Memory]
menu.

Selecti M for U F Video (FM) / Saving | to F M
Download fri YW, SomanUaTe ot KIS Gals Begtls A/ Dowproad: | Saving Images to Frame Memory
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Importing and Exporting
Images

You can use a USB flash drive to import images to the unit
as frame memory, and export the frame memory saved in
the unit.

Importing Images

File formats supported for import
* TGA
» TIFF
* BMP

* Enter up to 25 single-byte alphanumeric characters
(including the extension) for file names. A file with a
name of 26 characters or more will not be displayed.

* If an image is too large, the protruding portions will be
cut. If an image is too small, the missing portions will be
filled with black.

* Import operations are not guaranteed for TGA and TIFF
files that include layer information.

1 Copy the images you want to import to the following
folder on a USB flash drive, and then insert the USB
flash drive into the USB connector of the unit.

Folder name: \Sony\MCS\FM

2 Display the [Frame Memory] menu, turn the V1 knob
to select [Import], and press this knob.

The data in the USB flash drive is read and the files
that can be imported are displayed.

3 Turn the V1 knob to select the first file to import, turn
each knob to specify the frame memory and the
number of files to import, and press the V4 knob to
start importing.

When the V4 knob is pressed, the specified number of
files are imported.

¢ If you import TGA files or TIFF files that include
alpha channels, a frame memory that includes a key
source will be created.

* You can import RLE-compressed TGA files.

* Compressed TIFF files cannot be imported.

¢ If you import BMP files, or TGA or TIFF files that
do not include alpha channels, a frame memory with
an all-white key source will be created.

* If a frame memory is registered to the specified
frame memory number, it will be overwritten by the
imported image.

Export Frame Memory

You can export the frame memory stored in the unit to a
USB flash drive.

1 Insert the USB flash drive into the USB connector of
the unit.

2 Display the [Frame Memory] menu and turn the V1
knob to select [Export].

3 Turn each knob to select the frame memory to export,
and then press the V4 knob to start exporting.

When the V4 knob is pressed, the specified number of
frame memory is exported.

Knob |Parameter | Meaning Setting range
V2 Source Selects first FM1, FM2, FM3,
frame memory |FM4, FM5, FM6,
to export FM7, FM8, FM9,
FM10, FM11,
FM12
V3 Num Number of 1to12
frame memory
to export

* Only BMP format files can be exported. Alpha
channels cannot be added.

* The folder to which the files are exported and the file
names are as shown below.
Folder name: \Sony\MCS\FM
File name: YYMMDD-HHMMSS-##.bmp

Knob |Parameter | Meaning Setting range
V2 Dest Selects the first | FM1, FM2, FM3,
frame memory | FM4, FM5, FM6,
to import FM7, FM8, FM9,
FM10, FM11,
FM12
V3 Num Number of files |1 to 12
to import

II-36

Importing and Exporting Images

(# is the frame memory number [01 to 12])
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Importing and Exporting

Files

Importing and Exporting
Configuration Data

You can export configuration data in which various
settings of the unit have been saved to a USB flash drive,
and import saved configuration data to the unit.

Tip
Configuration data contains various settings of the unit.
When you want to, for example, restore previous settings,
you can easily make the settings by importing the
configuration data. We recommend that you save the
configuration data such as when you change the settings.

Exporting Configuration Data

1 Insert the USB flash drive into the USB connector of
the unit.

2 Press the FILE button in the menu control block to
display the [File] menu, turn the V1 knob to select
[Export Config], and press the V4 knob to start
exporting.

Tip
The folder to which the files are exported is as shown
below.

Folder name:
\Sony\MCS\CONFIG\Y YMMDD-HHMMSS

Chapter

The following settings are not saved under configuration

data.

Front panel buttons
* ACCESS/PFL (1 to 6)
* DIM

* MONITOR SEL

« CHON (I to 6)

* Bus delegation buttons (BKGD, KEY, AUX 1, AUX 2)

¢ Menu selection button

* Numeric keypad buttons (EFF, SNAPSHOT, DIRECT/

ESC)

Menus

S

Menu

Group

Parameter

Frame Memory

Input Freeze

Input, Freeze

Select FM
Export Source, Num
Frame Memory > Freeze |All -
Frame Memory > Import | All -
Misc Port Enable GPI, RS232C
File All -
File > Import Config All -
File > Import Snapshot All -
Setup > System Startup Mode | All
Date All
Time All

Miscellaneous
* Frame memory video

|
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Importing Configuration Data

1 Insert the USB flash drive that stores the configuration
data you want to restore into the USB connector of the
unit.

2 Display the [File] menu, turn the V1 knob to select
[Import Config], and press this knob.

The data in the USB flash drive is read and the
configuration data that can be imported is displayed.

3 Turn the V1 knob to select the configuration data to
import, and press the V4 knob to start importing.
When importing is complete, a message prompting

you to restart the unit appears.

4 Press the V3 knob (OK), and then turn off the unit and
turn it on again.

Tip
When you import configuration data, the startup mode
will automatically change to [User].

For details on the startup mode, see “Startup Mode” (page II-48).
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II-38 Importing and Exporting Snapshots

Importing and Exporting
Snapshots

You can export the snapshots stored in the unit to a USB
flash drive, and import the snapshots stored in the USB
flash drive to the unit.

Tip

Snapshots cannot be imported or exported in 3D mode.

Exporting Snapshots

1

2

Insert the USB flash drive into the USB connector of
the unit.

Display the [File] menu and turn the V1 knob to select
[Export Snapshot], turn each knob to specify the files
to export, and press the V4 knob to start exporting.

When the V4 knob is pressed, the specified number of
snapshots are exported.

Knob | Parameter | Meaning Setting range

V2 Source Number of first SS1 to SS20
snapshot to export

V3 Num Number of 110 20
snapshots to export

Tip
The folder to which the files are exported and the file
names are as shown below.
Folder name: \Sony\MCS\SNAPSHOT
File name: YYMMDD-HHMMSS-##.SSS
(## is the snapshot number [01 to 20])

When exporting snapshots, make sure that the number
of files in the folder does not exceed 99.
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Importing Snapshots

1

2

Insert the USB flash drive that stores the snapshots you
want to import into the USB connector of the unit.

Display the [File] menu, turn the V1 knob to select
[Import Snapshot], and then press the knob.

The data in the USB flash drive is read and the
snapshots that can be imported are displayed.

Tip
Snapshot files are displayed in order, starting with the
oldest.

Turn the V1 knob to select the snapshot to import, turn
each knob to specify the snapshots to import, and press
the V4 knob to start importing.

When the V4 knob is pressed, the specified number of
snapshots are imported.

Knob |Parameter | Meaning Setting range
V2 Dest Number of first | $S1 to SS20
shapshot to
import
V3 Num Number of 1to20
snhapshots to
import
Tip

If a snapshot is already stored to the specified snapshot
number, it will be overwritten by the imported
snapshot.
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Formatting a USB Flash
Drive

1

Insert the USB flash drive into the USB connector of
the unit.

Display the [File] menu, turn the V1 knob to select
[USB Memory Format], and press the V4 knob to start
formatting.

Tip
The following folders are created when formatting is
performed.
Folder name:\Sony\MCS\CONFIG

\Sony\MCS\FM
\Sony\MCS\SNAPSHOT

Formatting a USB Flash Drive
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3D System

Overview

With this unit, you can create a 3D video signal by
inputting a video for the left eye (L) and a video for the
right eye (R) as a pair.

This chapter describes the connections and settings
required for using the unit in a 3D system.

Flow of connections and settings

When using the unit in a 3D system, make the following
necessary connections and settings.

‘ Connecting Each of the Devices (page I1-6) ‘

l
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I1-40

‘ Setting the Signal Format and Video Size (page 11-41) ‘

|

‘ Turning 3D Mode On (page 11-41) ‘

|

‘ Confirming 3D Video Output (page 11-42) ‘

The connectors for inputting and outputting 3D video signals are fixed. When
configuring a 3D system, see “Example 2: When 3D system” (page 11-6) in
“System Configuration Examples”.

Notes and restrictions

The following restrictions apply when configuring a 3D

system including the unit.

* Configure the 3D system with only one MCS-8M unit.
Two units cannot be used linked together.

* When the unit is operated in a 3D system, only an HD
(10801/59.94, 1080i/50, 720p/59.94, or 720p/50) signal
format can be used. If the signal format is changed from
HD to SD, 3D mode is canceled.

* Audio embedded in HDMI inputs cannot be used.

Overview

Chapter

* The connectors that can be used for 3D video input and
the cross point buttons to which video signals can be
assigned are fixed as shown below.

Video Input Input Signal Cross Point
Connector Button
SDIIN 1 SDI1 (L) 1

SDIIN 2 SDI 1 (R)

SDIIN 3 SDI 2 (L) 2

SDIIN 4 SDI 2 (R)

* The connectors to which 3D video output signals can be
assigned are fixed as shown below.

Video Output Connector | Output Remark
signal

SDI OUT PGM PGM (L)

SDI OUT AUX 1 PGM (R)

SDI OUT AUX 2 PGM (L+R) | Side by Side

SDI OUT MULTI VIEWER | Multi Viewer

DVI-D OUT AUX PGM (L+R) | Side by Side

DVI-D OUT MULTI Multi Viewer

VIEWER

» Use a reference signal to synchronize the images from
the 3D video input device and this unit.

e The TALLY/GPI connector will be dedicated to
TALLY. The TALLY will be fixed at IN1 (SDIIN 1, IN
2) and IN2 (SDI IN 3, IN 4).
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Making the Necessary
Settings

Make the settings for operating the unit in a 3D system in

the [Setup] menu.

Display the [Setup] menu by pressing the SETUP button in
the menu control block.

Setting the Signal Format and Video

Size

1 Display the [Setup] menu, select [System] menu >

[System Format], and use the corresponding knobs to

make each of the following settings.

Knob |Parameter | Meaning |Setting Value
V3 Format Signal 108059 (1080i/
format 59.94), 108050
(1080i/50), 720p59
(720p/59.94),
720p50 (720p/50)
V4 Aspect Aspect 16:9
ratio of
video
Tip

The [Aspect] of the video is fixed at 16:9.

For details on the setting, see “Configuring the Signal Format and

Aspect Ratio” (9 Basic Operation).

2 Press the V3 or V4 knob.

A message prompting you to restart the unit appears.

3 Press the V3 knob (OK).

Download from Www.Somanuals.com. All Manuals Search And Download.

Turning 3D Mode On

1

3

Display the [Setup] menu, select [System] menu > [3D
Mode], turn the V4 knob to select [On].

Knob |Parameter | Meaning Setting
Value
V4 3D Turns 3D mode on/off | Off, On
Press the V4 knob.

A message prompting you to restart the unit appears.

Press the V3 knob (OK), and then turn off the unit and
turn it on again.

In 3D mode, the BKGD bus delegation button will be lit,
and the KEY, AUX 1, and AUX 2 buttons will be
disabled.

Next transition is fixed at BKGD.

Transition types will be fixed at MIX.

The FTB and KEY TRANS buttons in the transition
control block will be disabled.

The numeric keypad block will be disabled.

In the menu control block, only the MISC, FILE, and
SETUP buttons will be enabled.

In addition, menus will be restricted as follows.

[Misc] menu

Menu item | Restriction

Transition | Only the [Effect] transition rate is enabled.
Rate (1/2)

Transition | Setting is disabled.

Rate (2/2)

Color * Setting is disabled.

BKGD

Port Enable | [GPI] is fixed at [Disbl] (disable).

e Only [RS232C] can be selected.

[Setup] menu

Menu item | Restriction
Video * Movement to the sub-level setting is
(XPT) disabled (assignments for cross-point
buttons are fixed).
Video * Movement to the sub-level setting is
(Output) disabled (assignments for video output
are fixed).
Multi * Only setting of the number of sub-screens
Viewer is enabled.
* Assignment of video to the sub-screens is
fixed.
GPI/Tally * Movement to the sub-level setting is

disabled.

Making the Necessary Settings
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[File] menu

Menu item | Restriction

Import * Movement to the sub-level setting is
Snapshot disabled.

Export * Exporting is disabled.

Snapshot

* The following data will not be saved by the [Startup
Define] operation in the [Setup] menu. These settings
will return to default values at each startup.

— PGM bus cross-point: 1
— PST bus cross-point: 1
— Effect transition rate: 30

Confirming 3D Video Output

3D video input is assigned to the cross point buttons (PGM
buttons and PST/KEY buttons) 1 and 2.
Press cross point buttons 1 and 2 and confirm that 3D

video is output.

Making the Necessary Settings
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Controlling External

Devices

Enabling/Disabling
Operation from External
Devices

Enable or disable the GPI port which is used for operation
from external devices.

1 Display the [Misc] menu, turn the V1 knob to select
[Port Enable], and use the V3 knob to make the setting.

Knob | Parameter
V3 GPI

Meaning Setting range

Enbl (enable),
Disbl (disable)

Enables/disables
GPI port

Connecting with External
Devices

Set up a connection with an external device in [GPI/Tally]
of the [Setup] menu.

Tip
In 3D mode, [GPI/Tally] is not displayed.

For details on the [GPI/Tally] menu items, see “Details on [GPI/Tally]
Menu” (page 11-44).

For details on the pin assignment of the TALLY/GPI connector, see “TALLY/
GPI connector” (9 Basic Operation).

Chapter

Setting GPI Inputs

Set the operation and trigger type of the GPI input
contacts.

Settings menu: [Setup] menu > [GPI/Tally] menu >
[GPI Input 1] to [GPI Input 4] (page 1I-44)

You can select from the following operations.
NotUse: No operation

CT: Cut

AT: Auto Transition

KeyCT: Key Cut

KeyAT: Key Auto Transition

Aux1CT: Aux] Cut

Aux1AT: Aux] Auto Transition
Aux2CT: Aux2 Cut

Aux2AT: Aux2 Auto Transition

SS1 to SS20: Snapshot Recall (1 to 20)

You can select from the following trigger types.

NotUse: The input pulse is ignored.

Rise: The trigger is applied at the rising edge of the input
pulse.

Fall: The trigger is applied at the falling edge of the input
pulse.

Any: The trigger is applied when the input pulse is
inverted.

Setting GPI Outputs/Tallies

Set the GPI outputs or tallies.

Settings menu: [Setup] menu > [GPI/Tally] menu >
[GPI Output/Tally 1] to [GPI Output/Tally 8] (page
11-45)

You can select from the following trigger types.

NotUse: The output is fixed at a high level.

Rise: The trigger causes the output to decrease to a low
level, and that status will continue for a certain
duration (1 to 2 frames).

Enablin Dlsabmpl\%)eratlo fror'thA gr al Devic s/Connecting with External Devices
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Fall: The trigger causes the output to decrease to a high
level, and that status will continue for a certain

duration (1 to 2 frames).

Any: Every time the trigger is activated, the output’s high
and low levels change alternately.

If the GPI outputs are used as tallies, the relationship
between Tally 1 to 8 and the input signals is as follows.

Tally

Input Signal

SDI 1

SDI 2

SDI 3

SDI 4

DVI-1

HDMI-1/VIDEO 1

HDMI-2/VIDEO 2

O|IN|O[O| ||| =

HDMI-3/VIDEO 3

Details on [GPI/Tally] Menu

To display the [GPI/Tally] menu, display the [Setup] menu and press the V1 knob while [GPI/Tally] is selected.

Menu item

Description

Knob

Parameter

Meaning

Setting range

Reference
page

GPI Input 1

Set the operation and trigger type of the |V3
GPI input 1 contacts.

Action

Contact
operation

NotUse, CT, AT,
KeyCT, KeyAT,
Aux1CT, Aux1AT,
Aux2CT, Aux2AT,
SS1to SS20

V4

Edge

Trigger type

NotUse, Rise,
Fall, Any

11-43

GPI Input 2

Set the operation and trigger type of the |V3
GPI input 2 contacts.

Action

Contact
operation

NotUse, CT, AT,
KeyCT, KeyAT,
Aux1CT, Aux1AT,
Aux2CT, Aux2AT,
SS1 to SS20

V4

Edge

Trigger type

NotUse, Rise,
Fall, Any

11-43

GPI Input 3

Set the operation and trigger type of the |V3
GPI input 3 contacts.

Action

Contact
operation

NotUse, CT, AT,
KeyCT, KeyAT,
Aux1CT,
AuxiAT,
Aux2CT, Aux2AT,
SS1to SS20

V4

Edge

Trigger type

NotUse, Rise,
Fall, Any

11-43

Details on [GPI/Tally] Menu
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Menu item | Description Knob | Parameter | Meaning Setting range Reference
page
GPI Input 4 | Set the operation and trigger type of the | V3 Action Contact NotUse, CT, AT, |11-43
GPI input 4 contacts. operation KeyCT, KeyAT,
Aux1CT, Aux1AT,
Aux2CT,
Aux2AT, SS1 to
SS20
V4 Edge Trigger type NotUse, Rise,
Fall, Any
GPI Set GPI Output 1 or Tally 1. V2 Use Selects whether | Tally, GPIOut 11-43
Output/ to use as tally or | (GPI output)
Tally 1 GPI output
V3 Action Operation when | NotUse, CT, AT,
used as GPI KeyCT, KeyAT,
output Aux1CT, Aux1AT,
Aux2CT, Aux2AT
V4 Edge Trigger type NotUse, Rise,
when used as Fall, Any
GPI output
GPI Set GPI Output 2 or Tally 2. V2 Use Selects whether |Tally, GPIOut 11-43
Output/ to use as tally or | (GPI output)
Tally 2 GPI output
V3 Action Operation when | NotUse, CT, AT,
used as GPI KeyCT, KeyAT,
output Aux1CT, Aux1AT,
Aux2CT, Aux2AT
V4 Edge Trigger type NotUse, Rise,
when used as Fall, Any
GPI output
GPI Set GPI Output 3 or Tally 3. V2 Use Selects whether |Tally, GPIOut 11-43
Output/ to use as tally or | (GPI output)
Tally 3 GPI output
V3 Action Operation when | NotUse, CT, AT,
used as GPI KeyCT, KeyAT,
output Aux1CT, Aux1AT,
Aux2CT, Aux2AT
V4 Edge Trigger type NotUse, Rise,
when used as Fall, Any
GPI output
GPI Set GPI Output 4 or Tally 4. V2 Use Selects whether | Tally, GPIOut 11-43
Output/ to use as tally or | (GPI output)
Tally 4 GPI output
V3 Action Operation when | NotUse, CT, AT,
used as GPI KeyCT, KeyAT,
output Aux1CT, Aux1AT,
Aux2CT, Aux2AT
V4 Edge Trigger type NotUse, Rise,
when used as Fall, Any
GPI output
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Menu item | Description Knob | Parameter | Meaning Setting range Reference
page
GPI Set GPI Output 5 or Tally 5. V2 Use Selects whether | Tally, GPIOut 11-43
Output/ to use as tally or | (GPI output)
Tally 5 GPI output
V3 Action Operation when | NotUse, CT, AT,
used as GPI KeyCT, KeyAT,
output Aux1CT, Aux1AT,
Aux2CT, Aux2AT
V4 Edge Trigger type NotUse, Rise,
when used as Fall, Any
GPI output
GPI Set GPI Output 6 or Tally 6. V2 Use Selects whether |Tally, GPIOut 11-43
Output/ to use as tally or | (GPI output)
Tally 6 GPI output
V3 Action Operation when | NotUse, CT, AT,
used as GPI KeyCT, KeyAT,
output Aux1CT, Aux1AT,
Aux2CT, Aux2AT
V4 Edge Trigger type NotUse, Rise,
when used as Fall, Any
GPI output
GPI Set GPI Output 7 or Tally 7. V2 Use Selects whether |Tally, GPIOut 11-43
Output/ to use as tally or | (GPI output)
Tally 7 GPI output
V3 Action Operation when | NotUse, CT, AT,
used as GPI KeyCT, KeyAT,
output Aux1CT, Aux1AT,
Aux2CT, Aux2AT
V4 Edge Trigger type NotUse, Rise,
when used as Fall, Any
———— GPI output
———— GPI Set GPI Output 8 or Tally 8. V2 Use Selects whether | Tally, GPIOut 11-43
Output/ to use as tally or | (GPI output)
g Tally 8 GPI output
}% V3 Action Operation when | NotUse, CT, AT,
~ used as GPI KeyCT, KeyAT,
g output Aux1CT, Aux1AT,
2 Aux2CT, Aux2AT
= V4 Edge Trigger type NotUse, Rise,
Y when used as | Fall, Any
§ GPI output
o On Air Set the reference signal for the on-air V4 Source Reference signal | PGM, Aux1, Aux2 | —
2 |Source tally. for on-air tally
[0}
(7]

I1-46

Notes on setting values

PGM: Tally output for input signals being
output from PGM.

Aux1: Tally output for input signals being
output from AUX1.

Aux2: Tally output for input signals being
output from AUX2.

Details on [GPI/Tally] Menu
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Setup ([Setup] Menu)

Overview

Set up the overall system in the [Setup] menu.

The [Setup] menu contains the following items.

System Setup (System)

Make system related settings in the items of the [Setup]

Chapter

menu > [System] menu.

Supported input reference signals

You can use any of the following signals as the input

reference signal for the unit.

Signal Input reference signal
format b Trisync |SD Black
Burst
HD system | 1080i/59.94 59.94 59.94
1080i/50 50 50
720p/59.94 59.94 59.94
720p/50 50 50
SD system | 480i/59.94 - 59.94
576i/50 - 50

and firmware.

Menu item Description Reference
page
Startup Save the current setup data. |Basic
Define Operation
System Make system related settings. | I1-47
Audio Make audio related settings. |11-49
Video (Input) | Make video input related 11-51
settings.
Video (XPT) | Assign video input signals to | I1-52
cross point buttons.
Video Make video output related I1-53
(Output) settings.
Video (Misc) | Make other video related 11-54
settings.
Multi Viewer | Set up Multi Viewer. Basic
Operation
GPI/Tally Make GPI and tally control 11-43
related settings.
Information Display various information 11-54
on the unit.
Install Install application software 11-54

To display the [Setup] menu
Press the SETUP button in the menu control block.

To select a menu item

Display the [Setup] menu and then turn the V1 knob to
select a menu item.
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Details on [System] Menu

Menu item

Description

Knob

Parameter

Meaning

Setting range

Confirmation
(press knob)

System
Format

Set the format and aspect ratio to be
used by the unit.

(® Basic Operation: “Configuring the
Signal Format and Aspect Ratio”)

If you press the V3 or V4 knob, a
message prompting you to restart the
unit appears. Press the V3 knob (OK),
and then turn off the unit and turn it on
again.

V3

Format

Signal format

108059,
108050,
720p59,
720p50,
480i59, 576i50,
Test1, Test2,
Test3

Necessary

V4

Aspect

Aspect ratio

16:9, 4.3

Necessary

3D Mode

When using a 3D system, turn 3D mode
on.
(See “Turning 3D Mode On” (page 11-41))

V4

3D

Turns 3D mode
on/off

Off, On

Necessary

System
Reference

Select the input reference signal.

BB (Black Burst): Black burst signal

Tri (Tri Sync): Tri-level sync for HD
system

INT (Internal): Internal reference signal
of unit (See “Supported input
reference signals” (page I1-47))

If you press the V4 knob, a message
prompting you to restart the unit appears.
Press the V3 knob (OK), and then turn off
the unit and turn it on again.

V4

Ref

Input reference
signal

BB, Tri, INT

Necessary

REF OUT
Phase

Select the output reference signal phase
using the output video as a reference.

Notes on setting values
—1: One line in advance of output video.
0: Equal phase as output video.

If you press the V4 knob, a message
prompting you to restart the unit appears.
Press the V3 knob (OK), and then turn off
the unit and turn it on again.

V4

Phase

Output reference
signal phase

-1,0

Necessary

Startup
Mode

Select the setup mode (Startup mode)

used by the unit at startup.

Fact (Factory): Starts with the factory
default settings.

User: Starts using the setup data saved
in [Setup] menu > [Startup Define].

(® Basic Operation: “Saving and

Selecting Settings”)

V4

Def

Startup mode

Fact, User

Necessary

Date

Set the date for the unit’s internal clock.
(® Basic Operation: “Configuring the
Date and Time”)

V2

Year

Year

2000 to 2099

Necessary

V3

Month

Month

11012

Necessary

V4

Day

Day

1to 31

Necessary

Time

Set the time for the unit’s internal clock.
(® Basic Operation: “Configuring the
Date and Time”)

V3

Hour

Hour

0to 23

Necessary

V4

Min

Minute

0to 59

Necessary

LCD
Backlight

Adjust the brightness of the backlight of
the menu display.

V4

Bright

LCD backlight
brightness

Min (minimum),
1,2,3,4,5,6,
Max
(maximum)

Not
necessary

System Setup (System)
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Audio Setup (Audio)

Assign audio signal inputs to channel faders and make audio related settings in the items of the [Setup] menu > [Audio]
menu.

SDI output embedded audio and audio signal combinations

The following table shows the possible combinations for output.

Embedded Audio Possible Combinations for Output

SDI1to4 (L) PGM-L |MIX-L |AUX1 AUX2 | AUX1 AUX2 | AUX1 AUX2 | None None
SDI 1 to 4 (R) PGM-R |MIX-R |AUX1 AUX2 |AUX2 |AUX1 None None AUX1 AUX2
Tip

PGM and MIX are handled as a pair.

* When PGM/MIX is assigned to either L or R, the same assignment is made to the other automatically. For example, if
L is assigned to “PGM-L,” R is assigned to “PGM-R.”

* If one of L and R is then assigned to other than PGM/MIX, the other is automatically set to “None.”

Details on [Audio] Menu

Menu item | Description Knob | Parameter | Meaning Setting range
AudioInput | Assign the audio signals input from the audio input | V3 Left L audio signal NotUse, M/L1,
Assign 1 connectors to channel faders 1 to 6. M/L2, M/L3, M/L4,
to (® Basic Operation: “Assigning Audio Input Signals M/L5, M/L6, L7, L8,
Audio Input | to the Channel Faders”) SDI1L, SDI2L,
Assign 6 SDI3L, SDI4L,

In HD mode, SDI 1 to 4 and HDMI 1 to 3 are handled HDMI1L, HDMI2L,

. . HDMI3L

in pairs.

* When embedded audio is assigned to either L or | V4 Right R audio signal NotUse, M/L1,

R, the same assignment is made to the other M/L2, M/L3, M/L4,
automatically. For example, if L is assigned to M/L5, M/L6, L7, L8,
“SDI1L,” R is assigned to “SDI1R.” SDI1R, SDI2R,

* If one of L and R is then assigned to other than the SDI3R, SDI4R,
embedded audio of, for example, L8, the other is HDMI1R, HDMI2R,
automatically set to “NotUse.” HDMI3R

MIC/LINE | Adjust the mic/line level for each channel fader. V4 Level Input level —44 dB, —20 dB,
1 Level Adjust a level when, for example, the peak indication +4 dB
to lights red or when the input signal indication does not
MIC/LINE |light even though an audio signal is being input.
6 Level (® Basic Operation: “Assigning Audio Input Signals
to the Channel Faders”)
SDI OUT | Assign the audio signals output from PGM OUT/MIX | V3 Left Audio signalto | None, AUX1,
PGM OUT/AUX OUT 1/AUX OUT 2 connectors to the assign AUX2, PGM-L,
Assign embedded audio output from the PGM connector of MIX-L
SDIOUT. V4  |Right Audio signalto | None, AUXT,
For details on the possible combinations for output, see page II-49. assign AUX2, PGM-R,
MIX-R
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Menu item | Description Knob | Parameter | Meaning Setting range
SDIOUT | Assign the audio signals output from PGM OUT/MIX |V3 Left Audio signalto | None, AUX1,
AUX1 OUT/AUX OUT 1/AUX OUT 2 connectors to the assign AUX2, PGM-L,
Assign embedded audio output from the AUX 1 connector of MIX-L
SDIOUT. V4 |Right Audio signalto | None, AUX1,
For details on the possible combinations for output, see page II-49. assign AUX2, PGM-R,
MIX-R
SDI OUT | Assign the audio signals output from PGM OUT/MIX | V3 Left Audio signalto | None, AUX1,
AUX2 OUT/AUX OUT 1/AUX OUT 2 connectors to the assign AUX2, PGM-L,
Assign embedded audio output from the AUX 2 connector of MIX-L
SDIOUT. V4 |Right Audio signalto | None, AUX1,
For details on the possible combinations for output, see page II-49. assign AUX2, PG M-R,
MIX-R
SDI OUT | Assign the audio signals output from PGM OUT/MIX |V3 Left Audio signalto | None, AUX1,
MULTI OUT/AUX OUT 1/AUX OUT 2 connectors to the assign AUX2, PGM-L,
VIEWER | embedded audio output from the MULTI VIEWER MIX-L
Assign | connector of SDI OUT. V4 |Right Audio signalto | None, AUX1,
For details on the possible combinations for output, see page II-49. assign AUX2, PGM-R,
MIX-R
Audio Allows you to delay the audio output from the PGM | V3 PGM Delay time for 0.00 to 7.50 (1.00)
Output OUT and MIX OUT connectors on a frame basis. If audio output
Delay 1 the output video is delayed with respect to the audio, from PGM OUT
you can delay the audio to synchronize it with the connector
video. V4 | MIX Delay time for | 0.00 to 7.50 (1.00)
[ Note | audio output
Adjusting the delay time may result in noise being from MIX OUT
generated. connector
Audio Allows you to delay the audio output from the AUX | V3 AUX1 Delay time for 0.00 to 7.50 (1.00)
Output OUT 1 and 2 connectors on a frame basis. If the audio output
Delay 2 output video is delayed with respect to the audio, you from AUX OUT 1
can delay the audio to synchronize it with the video. connector
[ Note | V4 AUX2 Delay time for 0.00 to 7.50 (1.00)
Adjusting the delay time may result in noise being audio output
generated. from AUX OUT 2
connector
_ Output Adjust the level of audio output to each output V2 MIX Output level from | —- to +10 dB
—— Level destination. MIX OUT (0 dB)
——— connector
Q The output level of the audio output from the SDI V3 AUX1 Output level from | — to +10 dB
5 OUT PGM connector can be adjusted with the AUX OUT 1 (0 dB)
g program fader in the audio control block. connector
® V4 AUX2 Output level from | — to +10 dB
£ AUX OUT 2 (0 dB)
= connector
% Oscillator | You can make the settings for outputting the V2 Freq Frequency of Off, 100 Hz,
= oscillator signal used for adjustment. oscillator signal | 440 Hz, 1 kHz,
é 10 kHz
If other than “Off” is selected for [Freq] when the V3 Level Output level of | —to 0 dB
output destination of the oscillator signal is set in oscillator signal | (—20 dB)
[Term], the DIM button lights and the output level for [y/4 Term Terminal of None. PGM. MIX
the headphones or monitor is automatically reduced. oscillator signal AUX1, AUX2, All
(all output
destinations)

II-50

Audio Setup (Audio)
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Video Input Setup (Video (Input))

Make video input related settings in the items of the [Setup] menu > [Video (Input)] menu.

About DVI input signals

* Set the resolution of the DVI signal to be input to one of the following in accordance with the setting of the signal format

of the unit (page I1-48). Normal images may not be obtained with other resolutions.

Signal Resolution |1080i/59.94, | 720p/59.94, 720p/50,
1080i/50 480i/59.94, 576i/50

Analog XGA (60 Hz) 1024 x 768 Yes Yes

WXGA (60 Hz) | 1280 x 768 Yes Yes

SXGA (60 Hz) |1280 x 1024 Yes Yes
Digital HDTV (50 Hz) |1920 x 1080 Yes -

HDTV (60 Hz) |1920 x 1080 Yes -
Tip

Although signals with resolutions other than 1920 x 1080 may be accepted when DVI input signals are set to digital,
operation is not guaranteed.

* The image size of the DVI input signals will be adjusted to fit the screen of the unit’s signal format while maintaining
its aspect ratio.

Details on [Video (Input)] Menu

Menu item | Description Knob | Parameter | Meaning Setting range
SDI1 Set the SDI signals to input via the SDI IN 1 to 4 V3 FS Frame Off, On
to connectors. synchronizer
SDI4 V4 Name Input source | IN1 to IN8, CAM1
name to 8, VTR1 to 8,
PC1 to 8, SDI1 to
4,DVI,HDMI1t0 3, | =——
VIDEO1 to 3 ——
DVI Set the format and input source name of the signalto | V3 Format Format of XGA, SXGA, o
input via the DVI-I IN connector. When you change the DVI-I input WXGA, HDTV50, 3
signal format, press the V3 knob to confirm the change. video signal HDTV60 S
* For details on the DVI signal to be input, see “About |yv4 Name Input source | IN1 to IN8, CAM1 o
DVl input signals” (page II-51). name to 8, VTR1 t0 8, &
* For details on the formats of DVI-I input video PC1t08, SDI11t04, S
signals, also see “Configuring the Format of the DVI, HDMI1 to 3, G
Signal Input to the DVI-I Connector” (% Basic VIDEO1 to 3 g
Operation). Eg
HDMI1 Set the input source names of the HDMI input signals | V4 Name Input source | IN1 to IN8, CAM1 g
to to be input via the HDMI IN 1 to 3 connectors. name to 8, VTR1 t0 8, =
HDMI3 PC1to 8, SDI1 to 4,
DVI, HDMI1 to 3,
VIDEO1 to 3
VIDEO1 Set the pedestal levels and input source names of the |V3 Setup Pedestal level |OIRE, 7.5IRE
to video input signals to be input via the VIDEO IN 110 3 [y4 Name Input source | IN1 to IN8, CAM1
VIDEOS connectors.

When you change a pedestal level, confirm the
modification by pressing the V3 knob.

name

to 8, VTR1 to 8,
PC1to8,SDI1to4,
DVI, HDMIA1 to 3,
VIDEO1 to 3
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Assigning Video Input
Signals to the Cross Point
Buttons (Video (XPT))

Assign video signals to the cross point buttons (PGM
buttons and PST/KEY buttons) in the items of the [Setup]
menu > [Video (XPT)] menu.

For details on the setting procedure, see “Assigning Video Signals to the
Cross-Point Buttons” (< Basic Operation).

Tip

In 3D mode, this menu is not displayed.

Shift button function: Off (non-shift mode)

Hinnn.

PST/
KEY

]

Hinnn.

1 2

3 4 5 6 7 8

Shift button function: On (shift mode)

HiN .

PST/
KEY

]
Hinn.

2
9

]

]
3 4 5 6 7

10 11 12 13 14 Shift

The following table shows the factory default settings for

assignments.
Using the Shift Button Function PGM/PST Cross | Initial Value
) . ) Point Button

By using the cross Pomt button 8/SHIFT as the Shift 1104 SDIIN 1 to 4 (SDI1 to SDI4)

button, you can assign a total of 14 materials (seven to

cross buttons 1 to 7, and seven to cross buttons 1 to 7 + 5 DVI- (DVI)

Shift button (cross point button 8/SHIFT)). 6108 HDMI'IN 1 to 3 (H/V1 to H/V3) in HD

mode
Settings menu: [XPT Shift Mode] (page I1I-52) V'DdEO IN1to 3 (H/V1 to H/V3) in SD
mode

Numbers are assigned to the cross buttons as shown below 9 Color background (ColBg)

in accordance with whether or not the Shift button function 10 Frame memory (FM)

is on or off. 11 Program output (PGM)

12t0 14 Black signal (Black)
—— Details on [Video (XPT)] Menu

o
3
-c% Menu item | Description Knob | Parameter | Meaning Setting range
3: XPT Assign the video signals input from the video input | V4 Source Video signals Black, SDI1 to 4,
2 Assign 1 connectors and internally generated signals to cross DVI, H/V1 to 3,
2 to point buttons 1 to 14 (PGM buttons, PST/KEY ColBg, FM, PGM
& |XPT buttons).
5, |Assign 14
? XPT Shift | Select whether to use cross point button 8 as a Shift | V4 Mode Switches Off, Hold, Lock
£ Mode button. between shift

Hold: The button operates as a shift button, and the
cross point buttons on the shift side are enabled
while the button is pressed.

Lock: The button operates as a shift button, and
each press switches between the assignments
on the shift side and non-shift side.

Off: The button operates as cross point button 8.

and non-shift
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Video Output Setup (Video (Output))

Set the video output signal to assign to each video output connector in the items of the [Setup] menu > [Video (Output)]

menu.

Tip

In 3D mode, this menu is not displayed.

Details on [Video (Output)] Menu

Menu item | Description Knob | Parameter | Meaning Setting range
SDIOUT | Select the signal to assign to the SDI OUT PGM V4 Output Output video PGM, PVW,
PGM connector. signal Aux1PG, Aux1PV,
Assign Aux2PG, Aux2PV,
Notes on setting values MV
PGM: Program
PVW: Preview
Aux1PG: Aux1 program
Aux1PV: Auxi preview
Aux2PG: Aux2 program
Aux2PV: Aux2 preview
MV: Multi Viewer
SDI OUT | Select the signal to assign to the SDI OUT AUX 1 V4 Output Output video PGM, PVW,
AUXA1 connector. signal Aux1PG, AuxiPV,
Assign Aux2PG, Aux2PV,
MV
SDI OUT | Select the signal to assign to the SDI OUT AUX 2 V4 Output Output video PGM, PVW,
AUX2 connector. signal Aux1PG, Aux1PV,
Assign Aux2PG, Aux2PV,
MV
SDI OUT | Select the signal to assign to the SDI OUT MULTI V4 Output Output video PGM, PVW,
MULTI VIEWER connector. signal Aux1PG, Aux1PV,
VIEWER Aux2PG, Aux2PV, —
Assign Mv —
DVIOUT | Select the signal to assign to the DVI-D OUT V4 Output Output video PGM, PVW,
AUX connector in HD mode, and to the VIDEO OUT AUX signal Aux1PG, Auxi1PV, ;:?—
Assign connector in SD mode. Aux2PG, Aux2PV, 2
MV ®
DVIOUT | Select the signal to assign to the DVI-D OUT MULTI | V4 Output Output video PGM, PVW, &
MULTI VIEWER connector. signal Aux1PG, Aux1PV, S
VIEWER Aux2PG, Aux2PV, @
Assign Mv £
VIDEO Set the pedestal level of the video output signal that | V4 Setup Sets pedestal OIRE, 7.5IRE =
=}
=

is output via the VIDEO OUT AUX connector.
When you change a pedestal level, confirm the
modification by pressing the V4 knob.

level of VIDEO

OUT AUX
connector
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Setup of Other Video Related ltems (Video (Misc))

Make other settings related to videos in the items of the [Setup] menu > [Video (Misc)] menu.

Details on [Video (Misc)] Menu

Menu item | Description Knob | Parameter | Meaning Setting range
Switch Set the timing for switching videos. V4 Timing Switching timing | Any (fastest field
Timing that can be

If the signal format is set to 720p, this selection is p.roce.ssed), !:IE|d1

ignored (first field), Field2

' (second field)

Fade To Enable or disable the FTB button of the transition V4 Button Enables/disables | Enbl (enable)/Disbl
Black control block. FTB button (disable)

Displaying Various
Information (Information)

You can confirm various information on the application
software and the firmware in the items of [Setup] menu >
[Information].

Installing Application
Software and Firmware
(Install)

Install application software and firmware onto the unit
from [Setup] menu > [Install].

Tip
It is not possible to individually select which software to

install. All of the application software and firmware are
installed together at one time.

ideo M|

Setup of Other Video Related Items (
ownl

AR,

Varlo s Infor
anua s.com.

1 Copy the software to be installed to the USB flash
drive and then insert the USB flash drive into the USB
connector of the unit.

Tip
Copy the software to be installed to the following

folder.
Folder name: \Sony\MCS\INSTALL

2 Display the [Setup] menu > [Install] menu and then
press the V4 knob to start the installation.

When installation is complete, a message prompting
you to restart the unit appears. Confirm that no errors
have occurred (i.e., “E” is not displayed).

Tip
For details on the message that appears at installation
completion, see “Message List” (page II-55).

3 Press the V3 knob (OK), and then turn off the unit and
turn it on again.

4  Check the version information of the application
software and firmware under [Information] in the
[Setup] menu.

rRﬁtmanLrg%r@gg% / In(? Ilivr\1l Iégg_lication Software and Firmware (Install)




Appendix

Message List

When a problem occurs on the unit during operation, the
following types of messages appear. Before contacting
your local Sony representative, view the following lists
and check the possible solutions. If the problem persists,
write down the message number that appears and contact

Message example:

Message type

.] |Rate |SS
0001 30 PGM

File €9 4203 1— Message ID
USB memory is not recognized.
Confirm the USB memory.

|I\|on

your local Sony representative.

Select
% Enter

Message

The following message types exist.

@ (Error): Indicates an inability to continue operation,
malfunction, or other severe error.

A\ (Warning): Indicates that problems may occur if you
continue operation.

o (Information): Indicates a notification.

Errors
ID Message Solution
4001 An internal fan is stopped. The fan has stopped. Turn off the unit immediately, and contact your

Please turn off the system immediately. local Sony representative.
4002 The temperature in the system is rising. | The internal temperature of the system is high. Turn off the unit

Please turn off the system immediately. immediately, and contact your local Sony representative. —_—
4003 Unable to start. Try restarting the unit. If it does not restart, contact your local Sony ——

Please restart. representative. >

e

4004 Unable to start. Try restarting the unit. If it does not restart, contact your local Sony §

Please restart. representative. &
4005 Unable to start. Try restarting the unit. If it does not restart, contact your local Sony

Please restart. representative.
4201 Loading configuration file error. The selected configuration file may not be an MCS-8M supported file,

or it may be damaged.

4202 Saving configuration file error. The configuration file could not be saved. The USB flash drive may be

Please retry. malfunctioning or may not be supported.

Message List H-SS
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ID Message Solution
4203 USB memory is not recognized. Check whether operation has been verified with the respective USB
Confirm the USB memory. flash drive model.
4204 Formatting USB memory error. If operation has been verified, the USB flash drive may be damaged.
Please retry.
4205 Reading folder/file error.
Confirm the folder/file.
4206 Making folder/file error.
Please retry.
4207 Importing error.
Please retry.
4208 Exporting error.
Please retry.
4209 More than 99 files exist in the folder. Use a computer or other device to delete unnecessary files from the
folder so that the number of files does not exceed 99.
4210 No file in the folder. Files do not exist in the folder on the USB flash drive used as the
Confirm the folder. import source. Check the folder on the USB flash drive.
For details on folder configurations, see “Formatting a USB Flash Drive” (page II-39).
4211 No data to export. The data specified for export does not exist on the unit. Check that the
Confirm the source. frame memory, snapshot, or other data specified for export has been
created.
4212 Importing error. Check the requirements for TGA, TIFF, and BMP files that can be
Unsupported format. imported.
(See page 11-36)
Warnings
ID Message Solution
3001 No reference signal input state detected. | Reference signal input does not exist, although the input reference
Please confirm that the reference cable is | signal is set to [BB] or [Tril.
properly configured. Set [System Reference] to [INT], or connect the appropriate reference
signal.
(See page 11-48)
3002 Reference signal unlock state detected. The frequency of the reference signal input does not match that of the
Please confirm that the reference cable is | system format, or it is not locked. Check the reference signal input.
properly configured. (“Details on [System] Menu” (page II-48))
3003 Signal Format of HDMI IN 1 is different The input signal format of the HDMI IN 1 connector does not match
from the setting. that of the system format. Match the signal to the system format.
— Please match the signal format to the
———— system format.
— 3004 Signal Format of HDMI IN 2 is different The input signal format of the HDMI IN 2 connector does not match
z from the setting. that of the system format. Match the signal to the system format.
3 Please match the signal format to the
;% system format.
3005 Signal Format of HDMI IN 3 is different The input signal format of the HDMI IN 3 connector does not match
from the setting. that of the system format. Match the signal to the system format.
Please match the signal format to the
system format.
II-56 Message List
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Information

ID Message Solution
1101 The setting is changed. This appears when you change the system format or 3D mode, or
Perform "Startup Define", and then when the system otherwise needs to be restarted.
restart. Execute [Startup Define], and restart the unit.
1102 Finished. Please restart. This appears to display the results after installation of application
M: xx/B: xx/F: xx/R: xx/Font: xx software and firmware is complete.
FPGA1: xx/2: xx/3: xx/4: xx If “E” (error) appears, try installing again. If the problem persists,
M: Main contact your local Sony representative.
B: Boot
F: Firmware
R: Register
Font: Font
XX:
° IIOII: OK
e "E": Error
e "-": Not installed
1103 Import Finished. Please restart.

This appears when import of a configuration file is complete. Restart
the unit.
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II-58

Index

Numerics

3D Mode 1I-41, 11-48
3D System 11-40
8/SHIFT I-11

A

ACCESS/PFL Button -9, I-33, II-31
Adjustment Knobs 1 to 4 1-10
Incremental Adjustment I-11
Aspect 1I-17, I1-26, 11-30
Aspect Ratio I-17
Audio I-21,1-32
Mixing [-32
Monitoring 1-33
Audio Channel Menu 1I-31
AUX OUT Assign 11-33
Equalizer High 1I-32
Equalizer Low 1I-32
Equalizer Mid 1I-32
Filter II-31
Input Trim 1I-31
Limiter/Compressor 1I-32
MIX OUT Assign 1I-33
Pan 1II-32
PGM Assign 11-33
Audio Control Block 1-9
Audio Input Assign 1-21, I1-49
Audio Input Block I-13
Audio Input Signals I-21
Audio Inputs 1-22
Audio Level Meters 1-9, 1-33
Audio Menu 11-49
Audio Input Assign 11-49
Audio Output Delay 1I-50
MIC/LINE Level 1I-49
Oscillator 1I-50
Output Level II-50
SDI OUT AUX Assign 1I-50
SDI OUT MULTI VIEWER
Assign 1I-50
SDI OUT PGM Assign 11-49
Audio Mixing 1I-31
Audio Monitor 1-10
Audio Output Block I-13
Audio Output Delay 1I-50
Auto Adjust Execute 1-32, I1-27
Auto Chromakey Menu 1I-27
Auto Adjust Execute 11-27
Sample Mark [II-27
Sample Mark Adjust 1I-27
AUTO TRANS Button I-11,1-26, II-8
AUX 1 and 2 Buttons I-11

Index

AUX OUT Assign 1I-33

BKGD Button 1-11,I-12, 1-35
Border Adjust 1I-25
Border Matte Adjust 1I-25
Bus Delegation 1I-9
Bus Delegation Button
I-11, 1-29, 1-35, 119, 11I-19
AUX 1 and 2 Buttons 1-11, II-9
BKGD Button I-11, I-35, 11-9
KEY Button I-11,1-29,1-35,11-9,
1I-19, 11-20

C

CH ON Button I-9,1-32
Channel Fader 1-9, 1-21, 1-32, I1I-31
Chr I-31
Chr Key Adjust 11-28
Chr Key Window 1I-28
Chr Key Window Adj II-28
Chroma Key 1-28, 1-30
Detailed Adjustments II-21
Chromakey Auto Adj I-31, I1-24
Chromakey Manual Adj 1I-24
Color BKGD 1I-8
Color Cancel 1I-28
Color Cancel Adjust 1I-28
Compressor 1I-32
Configuration Data 1I-37
CropH II-18
Crop V 1I-18
Cropping 1I-13
Cross-Point Button 1-19, I-25
Assigning Video Signals 1-19
Switching 1-25
Cross-Point Control Block 1-11
CUT Button I-11,I-25

D

Date I-18
Date and Time 1-18
Defocus 1-37
Digital Multi Effect II-7, I1-20
DIM Button I-9, I-33
Dimmer 1-33
Direct Selection 1-27
DIRECT/ESC Button I-12, 1-28
DME 1I-7, 1I-20
DME Wipe 1I-13
Basic Operations 1I-13
Detailed Adjustments 1I-13
DME Wipe Adjust 1I-15
DME Wipe Bkgd Color 1I-16
DME Wipe Edge 1I-16
DME Wipe Edge Color II-16

DME Wipe Modify Menu 1II-18
CropH 1I-18
Crop V 1I-18
Positioner 1I-18
Positioner Adjust 1I-18
Size 1I-18

Door 1-37

DVI 1-20, II-51

DVI Input Signals 1I-51

DVIOUT AUX Assign 1I-53

DVI OUT MULTI VIEWER

Assign 1I-53
DVI Video Inputs 1-20

E

EFF Button I-10,1-11,1-12,1-28,1-29,
1-30, II-10, 1I-15, 1I-19

Effect I-26

Effect Menu 1I-15
DME Wipe Adjust II-15
DME Wipe Bkgd Color 1I-16
DME Wipe Edge 1I-16
DME Wipe Edge Color II-16
Effect Transition II-15
Wipe Adjust II-15
Wipe Edge II-15
Wipe Edge Color 1II-15

Effect Pattern List 1-37

Effect Transition II-15

Effects 1-26

ENTER Button 1-12, 1-28, I-34

Equalizer II-32

Equalizer High II-32

Equalizer Low II-32

Equalizer Mid 1I-32

Export 1I-36

Export Config II-37

Export Snapshot 1I-38

Exporting 1I-36, I1-37, 1I-38
Configuration Data 1I-37
Frame Memory 1I-36
Snapshot 1I-38

F:

F1 and F2 Buttons I-10

Fade To Black II-54

Fader Lever 1-12, 1-26

FILE Button I-10, II-37

File Menu 1I-37, II-38, 1I-39
Export Config 1I-37
Export Snapshot 1I-38
Import Config II-38
Import Snapshot 1I-39
USB Memory Format 1I-39

Fine Key II-25

Fine Key Adjust H 1I-25
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Fine Key Adjust V. 1I-25
Flip Tumble 1-37
FM Button 1-10, II-34
Formatting USB Flash Drive 1I-39
Frame In/Out 1-26, I-37
Frame Memory II-34
Frame Memory Freeze II-35
Frame Memory Menu
11-34, 11-35, 11-36
Export 1I-36
Frame Memory Freeze II-35
Import 1I-36
Input Freeze 1I-34
Select II-35
Freezing 1I-34
Front Panel 1-9
FTB Button I-11, II-8, II-54

G

GPI Input 1-42, 11-43, 11-44
GPI Output 1-42, 11-43
GPI Output/Tally 11-45
GPI/Tally Menu II-44
GPI Input 11-44
GPI Output/Tally 11-45
On Air Source 11-46

H

HDMI II-51

Import 1I-36
Import Config 1I-38
Import Snapshot 1I-39
Importing 11-36, 11-38, 1I-39
Configuration Data 1I-38
Image II-36
Snapshot 1I-39
Information II-54
Input Freeze 1I-34
Input Reference Signals 1I-47
Input Signal Indicator 1-9, 1-22
Input Trim 1I-31

K

Key 1-28,1I-19
Basic Operations 1I-19
Detailed Adjustments I1-20
KEY Button I-10, I-11, I-12, I-29,
I-35, 1I-19, 11-20, 1I-23
Key DME Wipe II-24
Key DME Wipe Modify Menu 1I-30
Positioner 1I-30
Positioner Adjust 1I-30
Size 1I-30

Key Edge Type II-25

Key Fill Mat Adjust 11-23

Key Fill/Src Select 1I-23

Key Invert II-24

Key Mask 1II-25

Key Mask Box H 1I-25

Key Mask Box V. 1I-25

Key Menu 1I-23
Border Adjust 1I-25
Border Matte Adjust II-25
Chromakey Auto Adj II-24
Chromakey Manual Adj II-24
Fine Key II-25
Fine Key Adjust H II-25
Fine Key Adjust V. II-25
Key DME Wipe 1I-24
Key Edge Type II-25
Key Fill Mat Adjust 11-23
Key Fill/Src Select 1I-23
Key Invert II-24
Key Mask 1I-25
Key Mask Box H 1I-25
Key Mask Box V. 1I-25
Key Soft Edge 1I-25
Key Transition II-23
Key Type Select 1I-23
Key Wipe 1I-24
Key Wipe Edge 1I-24
Lin Key Adjust 1I-23
Lin Key Mode II-24
Lum Key Adjust 1I-23
Lum Key Mode 1I-23
Resizer II-23

Key Soft Edge 1I-25

KEY TRANS Button
1-12, 11-8, 11-20, 11-23

Key Transition II-20

Key Type II-21

Key Type Select 1-29, I-31, 11-23

Key Wipe 1I-24

Key Wipe Edge 1I-24

Key Wipe Modify Menu 1I-29
Aspect 1I-30
Multi  11-30
Multi Adjust 1I-30
Positioner 1I-29
Positioner Adjust 1I-29
Rotation 1I-29
Rotation Adjust 1I-29

L

LCD Backlight 11-48
Limiter II-32
Limiter/Compressor 1I-32
Lin Key Adjust 1I-23

Lin Key Mode II-24
Linear Key 1-28, II-21

Location II-26

Lum I-29

Lum Key Adjust 1I-23

Lum Key Mode II-23
Luminance Key 1-28, 1-29, II-21

M

Manual Chromakey Menu 1I-28
Chr Key Adjust 1I-28
Chr Key Window 1I-28
Chr Key Window Adj 1I-28
Color Cancel 1I-28
Color Cancel Adjust 1I-28
Menu
Operations 1-11
Viewing I-10
Menu Control Block I-10
Menu Selection Button I-10
EFF Button I-10, II-15
FILE Button I-10, II-37
FM Button 1-10, II-34
KEY Button I-10, II-23
MENUI and 2 Buttons I-10
MISC Button I-10, II-8
SETUP Button 1-10, I-17, I-18,
1-19, 1-20, 11-47
MENUI and 2 Buttons I-10
Message List II-55
MIC/LINE Level 1-22, I1-49
MISC Button I-10, II-8
Misc Menu 1I-8
Color BKGD 1I-8
Port Enable 1I-8
Transition Rate 1I-8
Mix 1-26, 1-27,1-37, 1I-20
MIX Button
I-11, 1-27, 1-29, 1-30, 1I-19
MIX OUT Assign 1I-33
MONITOR LEVEL Adjustment
Knob 1-9,1-33
MONITOR SEL Button 1-9, I-33
Mosaic 1-37
Multi 1I-17, 1I-30
Multi Adjust 1I-17, 1I-30
Multi Viewer 1-23

N

NAM 1-37,11-7
Next Transition Selection Button I-11
BKGD Button I-11,1-12
KEY Button I-11,1-12
Non-Additive Mix 1I-7
Numeric Buttons (0 to 9) I-12, I-27
Numeric Keypad 1-27
Numeric Keypad Block I-12

Index
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o)

On Air Source II-46
Oscillator II-50
Output Level 1I-50

P

Pan II-32
Peak Indicator 1-9, I-22
PFL 1-33
PGM Assign 11-33
PGM Cross-Point Button
I-11,1-19, I-25
Pin Configurations 1-42
PinP 1-37,1I-13
Port Enable 1I-8
POS Button I-10, II-11, II-13
Positioner 1I-16, II-18, I1I-29
Positioner Adjust
1I-16, I1-18, 11-29, 11-30
Pre-Fade Listen 1-33
Preview Video 1-23
Program Fader I-9, I-32
Program Video 1-23
PST/KEY Cross-Point Button
I-11,1-19, I-25

R

REF OUT Phase 11-48
Reference Signal Input/Output
Block I-14
Resizer 11-23
Resizer Menu 1I-26
Aspect 1I-26
Location II-26
Rotation 1I-27
Rotation Mode 1II-26
Rotation II-17, II-29
Rotation Adjust 1I-17, I11-29
Rotation Mode 1II-26

S

Sample Mark 1-31, II-27
Sample Mark Adjust 1-31, II-27
Saving Settings 1-35
SDI 1I-51
SDI OUT AUX Assign 1I-50, II-53
SDI OUT MULTI VIEWER

Assign 1I-50, II-53
SDI OUT PGM Assign 11-49, 11-53
Select 1I-35
Setup 11-47
SETUP Button

1-10, I-17, 1-18, I-19, 1-20, 11-47

Setup Menu 11-44, 11-47, 11-49, 1I-51,

11-52, 11-53, 11-54

Index

Audio 1I-49
GPI/Tally II-44
Information II-54
Install II-54
Multi Viewer 1-23
Startup Define 1-35
System 11-47
Video (Input) II-51
Video (Misc) 1I-54
Video (Output) II-53
Video (XPT) II-52
SHIFT II-52
Signal Assign 1-23
Signal Format 1-17
Size 1I-18
Slide 1-37
Snapshot 1-34, I1-38
Recalling 1-34
Saving [-34
SNAPSHOT Button 1-12,1-34
Specifications 1-39
Squeeze 1-37
Startup Define 1-35
Startup Mode 11-48
STORE Button 1-12, I-34
System Configuration Example
3D System 1I-6
HD System I-8
SD System 1II-5
System Format 1-17, I1-48
System Menu 11-48
3D Mode 11-48
Date 1I-48
LCD Backlight 1I-48
REF OUT Phase 11-48
Startup Mode 11-48
System Format 11-48
System Reference 11-48
Time 11-48
System Reference 11-48

T

Tally Input 1-42
Tally Output 11-43
Time I-18
Transition Control Block 1I-11
Transition Indicator I-11, I-27
Transition Rate 1-27, I1I-8
Transition Rate Area I-10
Transition Type II-7
Transition Type Selection Button
I-11
EFF Button
I-11, 1-29, 1-30, 1I-10, II-19
MIX Button
I-11, 1-27, 1-29, 1-30, 1I-19
Troubleshooting 1-38

Turning the Unit On/Off 1-16

U

USB Memory Format II-39

\'}

V1 I-11
V2 I-11
V3 I-11
V4 I-11
VIDEO II-51
Video (Input) I-20
Video (Input) Menu II-51
DVI 1I-51
HDMI 1I-51
SDI 1I-51
VIDEO II-51
Video (Misc) Menu II-54
Fade To Black II-54
Switch Timing 1I-54
Video (Output) Menu 1II-53
DVIOUT AUX Assign 1I-53
DVI OUT MULTI VIEWER
Assign 1I-53
SDI OUT AUX Assign 1I-53
SDI OUT MULTI VIEWER
Assign 1I-53
SDI OUT PGM Assign 1I-53
VIDEO 1I-53
Video (XPT) I-19
Video (XPT) Menu II-52
XPT Assign 11-52
XPT Shift Mode 1I-52
Video Input Block I-14
Video Output Block 1-14
Video Switching 1-25, II-7
Viewer Mode 1-23

w

Wipe 1-26,1-37, 1I-7, 11-10, 11-20
Wipe Adjust 1I-15
Wipe Edge 1I-12, II-15
Wipe Edge Color 1II-15
Wipe Modify Menu 1II-16
Aspect 1I-17
Multi 1I-17
Multi Adjust 1I-17
Positioner 1I-16
Positioner Adjust II-16
Rotation II-17
Rotation Adjust II-17
Wipe Patterns  1I-11

X

XPT Assign 1-19, 1I-52
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XPT Shift Mode 1I-52
X-Y Pointer 1-10, II-11, II-13
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The material contained in this manual consists of
information that is the property of Sony Corporation and is
intended solely for use by the purchasers of the equipment
described in this manual.

Sony Corporation expressly prohibits the duplication of
any portion of this manual or the use thereof for any
purpose other than the operation or maintenance of the
equipment described in this manual without the express
written permission of Sony Corporation.

Trademarks

HDMLI, the HDMI logo, and High-Definition Multimedia
Interface are registered trademarks or trademarks of
HDMI Licensing LLC.

Other products or system names appearing in this
document are trademarks or registered trademarks of their
respective owners.

Further, the ® or ™ symbols are not used in the text.
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